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Study of soil sampling tools, collection of representative soil sample, its processing and 

storage 

 

Soil sampling tools: 

 

Soil Sampling Tools: Core Sampler, Posthole Auger, Tube Auger, Screw Auger, spade 

pickaxe, khurpi, bucket, cloth bag, scale. 

 

AUGERS: 

Auger is an instrument used for taking soil sample in the field. Whenever soil samples are 

to be collected by easy and quick method the augers are used. Select the place from where the 

samples are to be collected and then work with auger. 

In general when the soil is completely dry, it is difficult to work with auger, but if the soil 

is moist sampling is easy. There are various types of augers used, depending upon the type of 

the soil depth of sampling and such other conditions. 

 

1) Screw auger : 

It works like a screw in the field. The soil adheres in the grooves. Soil at any depth can be 

taken up by making mark on the stem and working the auger upto the mark. It is taken up 

straight way and the soil is collected from the grooves. This auger is useful even if there is a 

crop in the field. 

This auger consists of three parts. 

1. Handle : It is a wooden/iron portion. 

2. Stem : It is of iron-length 35 cm. or desired length. 

3. Grooves : It is of iron-distance between two grooves is 2.5 cm. 

 

2. Dr.Leathers Auger : 

It consists of a strong hallow steel cylinder with a sharp cutting edge. It  is  useful for 

taking surface sample only. Twenty-five cm. Column of soil is collected in the cylinder. 

 

This auger : consists of three parts : 

1.Handle : It is a wooden/iron portion. 

2.Stem : It is of iron 



3.Cylinder : It is of Iron. 

 

3. American Soil Sampler : 

The flank pointed out cuts the soil at the desired depth upto 20 cm. Then by turning the 

handle the soil enters into the cavity and accumulates there. Then by turning it in a reverse 

way, slit is closed and the auger is taken out. The soil collected in the cavity is not allowed to 

fall down. This auger is useful  in sandy  soil. It works better in rice field and in water logged 

field. 

This auger consists of three parts : 

1. Handle : It is of Iron. 

2. Stem : It is of iron 

3. Cylinder : It is of Iron.  

 

Cylinder consists of three parts:  

1 .  Sliding covers  

2. Flank, 

3. Slit. 

 

4. Lyalpur Auger : 

The point of the auger enters into the soil. The soil is collected in the cylinder.  It can 

work upto the desired depth. The cutter piece at the end cuts the soil which is collected in the 

cylinder. Then the soil is removed from the cylinder. It is useful for taking the soil samples in 

irrigated conditions. 

This auger consists of three parts : 

1. Handle : It is of Iron 

2. Stem : It is Iron 

3. Cylinder : It is of iron, length 13” (30 cm) dist. 

In the cylinder, there is a slit of cavity of length 6” (15cm) and breadth ½” (1.5 cm.) 

5. Post hole auger: 

A chisel shaped point enters in the soil and the soil enters in the cylinder. While 

taking it out the tongue does not allow the soil to fall down. The auger works at any desired 

depth. It gives samples of surface, soil up to 25 cm.  In case if the soil is sufficiently deep, the 

deeper layers sample a may also be collected. 



 

This auger consists of three parts: 

1. Handle : It is of wooden portion. 

2. Stem : It is of iron. 

3. Cylinder : It is of iron consisting of side plates and tongue. The distance between 

two side plates is 6 cm. 

 

The different soil sampling tools are used for soil sampling 

1. Soil tube auger 

2. Screw auger 

3. Post hole auger 

4. Spade 

5. Khurpi/dager 

6. Bucket/ghamela 

 For sampling of soft and moist soil tube auger, spade or khurpi can be used 

satisfactory . 

 A screw type of auger may prove more convenient on hard/dry soil 

 Post hole auger useful for sampling of wet area like rice field 

 Tools for collecting the samples should be free from or any foreign materials 

which may contaminant the samples. 

 Bucket or Ghamela are used for collecting and mixing the soil sample 

 

Collection of soil samples : 

Purpose of collection of soil sample: Soil samples are collected from the field to study 

physical, chemical and biological properties of the soil. 

 

Procedure: - 

1. First divide the field according to the slope, colour of soil, depth, texture, management 

and cropping pattern, after demarcation of field into uniform portions each of which 

must be sampled separately. 

2. Then divide each portion into two parts, draw the Zigzag line having about 8 to 10 

corners on both the sides of middle line so that it will cover the whole area. 

3. Where the crops have been planted, collect the soil samples between the lines. 



4. Do not sample unusual area. Avoid area recently fertilized, old bunds, marshy spots, 

near trees, compost heaps or other than non-representative locations. 

5. Use proper sampling tools like auger soils, tube, phawda (spade) or Khurpi (Trowel) 

crop sampler. 

6. Before taking the sample scrap away surface litter or any stone etc. Collect the soil 

samples from 10 to 20 spots in the field depending upon the area. At each corner of the 

zigzag line take the samples by auger at the depth of 20-30 cm or with the help of trowel 

and spade by digging the “V” shaped pit up to plough depth. Then cut out uniform thick 

2 cm. Slice of soil from top to bottom (0-30 cm) of the exposed soil surface of “V” 

shaped pit. Collect the sample on the blade or in your hand and place it in clean bucket. 

Collect all the samples from the uniform area into the same bucket 

7. Pour the soil from the bucket on the piece of clean paper or cloth and mix thoroughly. 

Discard by quartering, excess soil and collect approximately one  kg. of soil. To quarter 

the sample, mix well, divide into four equal parts and reject opposite quarters. Mix the 

remaining two potions and repeat the procedure as many times as necessary to arrive at 

the desired size of sample. If the sample is wet or moist, dry it in the shade before 

putting into a plastic bag. Fill the sample into a plastic bag and put the plastic bag into a 

cloth bag. 

8. Fill out the information sheet completely and may be place inside the sample bag and put 

one outside the bag and send the sample to laboratory immediately for analysis. 

 

Sample Information Sheet 

1. Sample No. 

2. Date of collection of sample 

3. Name of the cultivator 

4. Address: Village 

5. Type of soil 

6. Survey No. 

7. Proposed crop / crops & Variety 

8. History of the field for the last 3 years crop, kind of fertilizer and quantity applied. 

9. Depth of sampling 

10. Field condition: Dry / Wet. 

11. Extent of sampled area in ha. 



1. Number of samples taken to make a composite sample. 

 

Preparation of Soil Sample : 

i. When air dry, break the lumps with a wooden pestle in a wooden mortar so that the 

aggregate particles are crushed but no actual grinding takes place. 

ii. Shift the soil through a sieve with round holes of 2mm (10 meshes) diameter sieve. Use 

wooden pestle and mortar for further crushing. Repeat the screening till the aggregate 

particles are fine enough to pass through the sieve and only stones and gravels remain. 

Before discarding this residue, weigh it and report as gravel and stones (detritus) 

iii. For special determination, it is necessary to weigh out small amount of soil i.e. organic 

matter, CaCO3 and chemical analysis, it is desirable to grind a representative sub sample 

and sieve it through 0.5 mm. Sieve (32 mesh) 

iv. For micronutrients like copper, iron, manganese and zinc, a brass sieve should be avoided 

and aluminum or plastic sieve with nylon netting should be used. 

v. Nitrate, ammonia, bacterial count and moisture determination must be carried out on soils 

obtained straight from the field. Air-drying of these samples is not permissible and not 

desired. 

vi. The processed samples are analyzed for texture, carbonate content, pH, EC and available 

nutrients. 

Storage of soil samples: 

Collected soil sample should be store in well labeled cloth bag size 13cm X 25 cm or 

plastic bottle (1Kg) 

 

Questions : 

1. Explain the procedure of collection of representative soil samples. 

2. State the importance of soil sampling. 

3. What is auger? Give the name various types of augers. 

4. What are the precautions to be followed during soil sampling? 

5. Why do you dry the soil sample in shade? 

6. Is it desirable to sample the field in each season? 

7. What is the relation between mesh and pre size in mm in sieve ? 

References : 

1) Perur, N.G. Subramanian, C.K, Muhr, G.R. and Ray H.E. (1973): Soil fertility evaluation to 



serve Indian farmers. 

2) Jackson, M.L. Soil chemical analysis (1973) prentice hall of India, Pvt. Ltd. New Delhi. 

3) Gupta P.K. (2007) Soil Plant Water and Fertilizer analysis , Agrobios (India) Jodhpour 

 

 

Reference URL 

  https://www.youtube.com/watch?v=E7ILKAmkw8I 

 https://www.youtube.com/watch?v=TYo9htjBo88 

 https://www.youtube.com/watch?v=RavNWfdU8I0 

 https://www.youtube.com/watch?v=nry_Mid9ctY 

  

https://www.youtube.com/watch?v=E7ILKAmkw8I
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https://www.youtube.com/watch?v=nry_Mid9ctY


Determination of bulk density of soil 

 

Bulk density of soil is expressed as the ratio of the mass (weight) of soil particle to their total 

volume including the pore space between the soil particles. Alternately, it is the weight of 

unit volume of dry soil. It is usually expressed in the unit of gram per cubic centimeter (g/cc) 

or mega gram per cubic meter (Mg/m3). In fine textured soil bulk density vanes from 1.00 to 

1.60 g/cc, whereas in coarse textured soil from 1.20 to 1.80 g/cc. 

 

𝐵𝑢𝑙𝑘 𝐷𝑒𝑛𝑠𝑖𝑡𝑦 =  
𝑊𝑒𝑖𝑔ℎ𝑡 𝑜𝑓 𝑠𝑜𝑖𝑙

𝑉𝑜𝑙𝑖𝑢𝑚𝑒 𝑜𝑓 𝑠𝑜𝑖𝑙
 

 

Here, the volume of soil means as it exists in situ i.e. in field condition. 

 

Equipments and Materials 

Core sampler consists of two cylinders fitted one inside the other (The inside cylinder is the 

sample holder; the outer core extends at both the ends; upper end to accept the hammer and 

lower end to form the cutting edge), knife, slide caliper, aluminium moisture box analytical 

balance, oven, desiccators. 

 

Procedure 

 

 Drive the sampler into a vertical soil surface slightly enough to fill the sampler but avoiding 

the compression of the soil in the confined space of sampler. 

 Using spade dig out the sampler without disturbing the natural position of soil within the 

sampler. 

 Separate the two cylinders retaining the soil mass undisturbed in the sample holder (inner 

core). 

 Trim the soil extending beyond each end of sampler with the help of sharp knife. Now the 

volume of sample holder is equal to the volume of soil. 

 Transfer the total soil from sample holder to a previously weighed moisture box and weigh it. 

 Dry it in the oven at 105°C until a constant weight is reached (10 to 15 hours). 

 Cool the moisture box and its content at room temperature in the desiccators and weigh it 

again. 



 Determine length and inner diameter of the sampler with the help of slide caliper. 

 

Calculation 

 

Say, 

Weight of aluminium box = W1 g  

Weight of aluminium box + field moist soil = W2 g  

Weight of aluminium box + oven dry soil = W3 g  

Weight of oven dry soil = (W3 - W3) g = Y g  

Weight of water in soil = (W2- W3) g = Z g 

Thus,  

Bulk Density of soil (g/cc)  =
𝑌

𝜋𝑑2ℎ
4

=
4𝑌

𝜋𝑑2ℎ
 

Where, d = inner diameter of the sampler, in cm h = height of the sampler, in cm 

 

Questions: 

1) Define bulk density of soil and state its significance. 

2) State the average bulk density of clay, sandy and silt soils of West Bengal. 

3) State reasons for variation in density of soil. 

 

Reference URL 

 https://www.youtube.com/watch?v=qcm1WTGlric 
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Determination of particle density of soil by pycnometer method 

 

Principle : 

Particle density of soil is the ratio of mass (weight) of solid particles to their total volume, 

excluding the pore space between particles. Bulk density is usually expressed in the unit of 

gram per cubit centimeter (g/cc) or mega gram per cubic meter (Mg/m3). For mineral soils the 

value usually varies from 2.60 - 2.75 g/cc. For general calculation average particle density of 

arable soil is considered to be 2.65 g/cc Particle density of organic matter (1.2 -1.7 g/cc) is 

much less than that of mineral soil. 

𝑃𝑎𝑟𝑡𝑖𝑐𝑙𝑒 𝐷𝑒𝑛𝑠𝑖𝑡𝑦 =  
 𝑀𝑎𝑠𝑠 𝑜𝑓 𝑠𝑜𝑖𝑙𝑖𝑑 𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒𝑠 𝑜𝑓 𝑠𝑜𝑖𝑙

𝑉𝑜𝑙𝑖𝑢𝑚𝑒 𝑜𝑓 𝑠𝑜𝑙𝑖𝑑 𝑝𝑎𝑟𝑡𝑖𝑐𝑙𝑒 𝑜𝑓 𝑠𝑜𝑖𝑙
 

 

 

Volume of solid particles is calculated indirectly by volume of fluid (usually water) displaced 

by the solid particles. Again, volume of water is calculated from the mass and density of 

water. 

 

Equipments and Materials 

Pycnometer fitted with a glass stopper having a vertical capillary opening (Fig. below), 

analytical balance, hot plate. 

 

Fig. Pycnometer 

 

Procedure 

 Weigh a clean, dry pycnometer and pour oven dry soil to nearly one quarter of its volume. 



  Weigh the pycnometer with soil after properly cleaning the outside of the pycnometer with 

dry cloth duster. 

 Fill about half of the volume of pycnometer with distilled water. 

 To expel entrapped air within the suspension gently boil the water for few minutes (5 

minutes). 

 Cool the pycnometer and its content to room temperature. 

 Fill the total volume of pycnometer with preboiled cooled distilled water. 

 « Insert the stopper carefully and clean outside of pycnometer with dry cloth. 

 Weigh the pycnometer with its content. 

 Remove soil from pycnometer and fill it with preboiled cooled distilled water and weigh it. 

 Record the room temperature.  

 

Calculation 

 

Weight of empty pycnometer = WA g 

Weight of pycnometer + oven dry soil = Wsg 

Weight of pycnometer + soil + water = Wsw g 

Weight of water filled pycnometer = Ww g 

Density of water at room temperature = Dvv g/cc 

 

Particle Density of soil (
g

cc
) =

𝑊𝑆 − 𝑊𝐴

{
(𝑊𝑊 − 𝑊𝐴) − (𝑊𝑆𝑊 − 𝑊𝑆)

𝐷𝑊
}
 

=
𝐷𝑊(𝑊𝑆 − 𝑊𝐴)

(𝑊𝑊 − 𝑊𝐴) − (𝑊𝑆𝑊 − 𝑊𝑆)
 

 

 

 

Questions : 

1) Define particle density. 

2) What is the significance of particle density 

 

Reference URL 

 https://www.youtube.com/watch?v=-PcD2XoBcA8&t=206s  



Determination of Porosity of Soil by Indirect Method 

 

Porosity or total pore space of soil is the fraction of soil volume not occupied by soil 

particles. Mathematically, it is the ratio of volume of pore space to total volume of soil. It is 

governed by the orientation of the soil solids. Porosity gives idea about the storage capacity 

of fluid (air and water). 

 

%Pore Space(f) = 100 − (100
𝐷𝑏

𝐷𝑝
)  = (1 −

𝐷𝑏

𝐷𝑝
) 100 

Where, Db and are the bulk density and particle density of soil respectively. 

Procedure 

 Determine bulk density and particle density of soil as Exp no 5 and 6 

 Calculate the porosity of soil using the above equation 

 

Result 

 

 

Questions :  

1. State the significance of porosity of soil in relation to plant growth. 

2. State the types of soil pores. 

 

 

Reference: 

1) A textbook of Soil Analysis by T.C. Baruah. H. P. Barthakar, Vikas publishing House 

Pvt. Ltd. 1997. Pp.11-12. 

2) Soil Physical Analysis by R.A. Singh, 1980. pp. 62-63.



Determination of moisture content in soil by gravimetric method 

 

Water plays a very significant role in soil-plant growth relationship. In fact, the soil water is a 

regulator of physical, chemical and biological activities in the soil. 

Water in a soil may be measured in a number of ways, viz. 

 

1. Gravimetric method (The standard method) 

2. Neutron scattering 

3. Gamma ray alternation, 

4. Soil moisture tension, and 

5. Electrical conductivity (Gypsum block). 

 

Gravimetric Method 

 

Principle : Weighed soil sample is placed in an oven at 1050C and it is died to constant weight. 

The weight difference is considered to be water present in soil sample. 

 

Apparatus : 

Sampling auger, Moisture cans / Aluminium box, Hot air oven, Balance 

 

Procedure : 

1. Weight the empty moisture boxes. 

2. Used the sampling to take a soil sample of 40-50 g. from the required depth. Put the soil 

immediately in the moisture box and close it to prevent loss of moisture by evaporation. 

3. Bring the boxes containing the moist soil to the laboratory and weight them immediately. 

Remove the lids and place the moisture boxes in oven at 1050 C for 24 hours. 

4. Allow the sample to cool for sometime in oven. Then close the boxes and put them in the 

desiccators for further cooling. After the completion of this step, weight the closed boxes 

with the oven dry soil. 

 

 



Observations : 

1. Weight of empty box - A 

2. Weight of box + moist soil - B 

3. Weight of box + oven dry soil - C 

4. Moisture content in soil - B-C 

5. Weight of oven dry soil - C-A 

 

Calculations : 

                                                (B-C) Loss in wt. 

Per cent moisture in soil = ----------------- x 100 i.e -------------------------- 100 

                                                 (C-A) Oven dry wt. of soil 

 

Questions: 

1. What do you mean by oven dry soil? 

2. What do you mean by constant weight? 

 

References: 

1. Khanna S.S. and Yadav, D.V. 1979.  Practical Manual for Introductory Courses in Soils. P. 

45- 4 

 

Reference URL 

 https://www.youtube.com/watch?v=AHD0G15kwvQ 
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Determination of soil pH 

 

A) Soil pH 

One of the most enlightening attributes of a soil is its pH. Whether a soil is acidic or basic 

has much to do with the solubility of various components the relative bonding of ions on 

exchanges sites and activity of various microorganisms. The plant nutrient is 6.5 to 7.5. Thomas 

(1957) noted that the three-soil pH availability is influenced by soil pH. The ideal pH range for 

availability of nutrients is 6.5 to 7.5. Thomas (1957) noted that three soil pH ranges are 

particularly informative pH less than 4 indicates the presence of free acid generally from 

association of sulphides: a pH below 5.5 suggests the likely occurrence of exchangeable Al and 

pH from 7.8 to 8.2 indicates the presence of CaCO3. 

 

I] Equipment for measurement of soil pH : 

 

The pH meter consists of two electrodes viz. (i) Glass electrode and (ii) Calomel electrode ( 

reference electrode ) 

 

A. Glass electrode: 

1. The glass electrode consists of thin-walled bulb of pH sensitive glass, sealed to a stem of 

high resistance glass. It is better to choose a lower resistance electrode 9 (pH range 0 to 

12) with a more repaid response and to tolerate the possibility of small errors caused by 

reaction between the electrode surface and the film of soil suspension in contact with it. 

New electrodes should be checked in at least three standard buffers, say near pH 4,7 and 

9 for linearity of response. 

2. The useful life of glass electrode is extended if it is kept most when not in use. Combined 

glass and reference electrode should also be stored in a buffer solution, but separate 

reference electrodes should have their liquid junctions immersed in nearly saturated KCl 

solution protected from evaporation. 

3. With continued use, the performance of glass electrode gradually worsens. Electrode with 

poor performance should be replaced. 

Erratic off scale readings indicate very high electrical impedance in the electrical circuit. 



Air bubbles interrupt the path between the glass bulb and the internal reference electrode. 

Gentle tapping and shaking usually dislodge these bubbles. 

B. Reference electrode: 

 

a. These electrodes are usually the calomel type with saturated KCl electrolyte. But Ag-

AgCl electrodes give quite satisfactory service and have an advantage in being easily 

repaired or even constructed in a laboratory. 

 

b. Calomel electrodes must not be heated above 70 0C . They should be closely inspected 

regularly to see that no air gaps have developed. 

 

c. The liquid junction between the reference electrode and the test liquid usually made 

with KCl solution, which is also the reference electrolyte. The liquid junction potential 

with soil suspensions is not the same with other electrolytes. The KCl solution used 

should not be saturated at any temperature above the minimum to which the electrode 

will be subjected. For example, a solution of 32 g KCl in 100ml water, is just undersalurated at 

15 0C. 

d. The KCl solution should flow through the liquid junction at a very low but detectable 

rate. 

e. The liquid junction of reference electrode should just enter the surface of the soil 

suspension in order to be in a zone of minimum clay concentration. This makes the 

junction potential as small as possible and closest to that in the standardizing buffer 

solution. The difference in the junction potential in buffer and suspension is included in 

the pH shown by the meter. 

 

II] Reagents: 

 

A. Standard buffer solution, pH 4.00. Prepare stock solution of 0.3 M potassium hydrogen 

phthalate by dissolving 15.3g of the analytical grade salt in about 225 ml of hot water. 

cooling the solution, and diluting it to 250 ml .Add a drop of toluene to discourage 

growth of micro organisms. For the standard buffer pH.4.0 mix 100 ml of the stock 



solution with 500ml water. Prepare the fresh solution every week. 

B. Standard buffer solution, pH 9.2 : Dissolve 3.81g sodium tetraborate (A.R) in water and 

dilute to 1000 ml. 

C. 1.0 N Potassium Chloride solution (A.R) 

 

III] Apparatus : 

Electrometric pH meter with glass and calomel electrodes. 

 

IV] Procedure : 

 

1. Weight 20g air dry soil in to breaker and add 50 ml distilled water. Stir at regular 

intervals for one hour. 

2. In the mean time turn the pH meter on, allow to warm up, and standardize the glass 

electrode using both the standard buffers. Remember to adjust the temperature 

compensation knob to the temperature of the solution. Measure the pH of the sample 

suspension, stirring the suspension well just before introducing the electrodes and note 

down the reading. 

3. Rinse the electrodes after each determination and carefully blot them dry with filter paper 

before the next determination. Standardize the glass electrode after every ten 

determinations. 

 

 

Result:  

 

The pH of given soil sample is …………. 

 

 

Questions: 

 

 What p and H stand for? 

 What is the soil: water ratio used in the determination of soil pH? 



 What is the utility of soil pH? 

 What are the factors affecting soil pH? 

 

Reference: 

 

1. Hesse. P.R. 1971. A textbook of Soil chemical analysis. John Murray. Pubi Ltd.50 

Albemarle, Street, London 

2. Jackson, M.L.1967. Soil chemical analysis. Practice-Hall of India Pvt. Ltd. New Delhi. 

Reference URL 

 https://www.youtube.com/watch?v=LzE-cwRFuoA 

 https://www.youtube.com/watch?v=4LuVLpF2OCU 
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Determination of electrical conductivity of soil 

 

Principle : 

The method is based upon the principle that conductivity of soil is nearly proportional to 

salts concentration. 

 

Reagents : 

Standard potassium chloride solution: 0.7456g of dry reagent grade potassium chloride is 

dissolved in freshly prepared double distilled water and made to one litre. At 25 0C it gives an 

electrical conductivity of 1411.8 x 10-4 (0.0014118) mhos/cm or 1.41 mmhos/cm . The 

conductivity bridge is to be calibrated and cell constant determined with the help of this solution. 

Even if the scale is marked directly in mhos/cm it is necessary to check and calibrate the 

instrument with the KCl solution. 

Procedure : 

10 g of soil is shaken intermittently with 25ml of distilled water in a 150 ml Erlenmeyer 

(conical) flask for one hour and allowed to stand. Alternatively, the clear extract after pH 

determination can be used for electrical conductivity measurement. The conductivity of the 

supernatant liquid is determined with the help of the salt (conductivity) bridge. The measurement 

of EC (expressed in mmhos/cm or dS/m.) is to be adjusted for known temperature (usually 25 

0C) of the solution by setting the knob provided for this purpose. 

Conversion factors: 

TDS (m.eq/L) = EC (dS/m) ×10  

TDS (ppm) = EC (dS/m) ×640  

TDS (%) = EC (dS/m) ×0.064  

Osmotic pressure (bars) = EC (dS/m) ×0.36 

 

 

 

 

 



 

Result : The given soil sample contains,  

 

EC (dS/m)   

TDS (m.eq/L)   

TDS (ppm)   

TDS (%)   

Osmotic pressure 

(bars) 

 

 

Inference: The given soil sample is…………………………………………………….. 

Questions 

1) Why it is essential to measure the electrical conductivity of soil? 

2) How will you measure the E.C.? 

3) Name the instrument used for conductivity measurement? 

4) What precautions will you take while measuring the E.C. ? 

 

References: 

Method of Soil Analysis : Part II (1965) Ed.C.A.Black Americal Socy of agronomy Madison , 

U.S.A. 

 

Reference URL 

 https://www.youtube.com/watch?v=C47w6B9NgL8 

  

https://www.youtube.com/watch?v=C47w6B9NgL8


 

Determination of Cation Exchange Capacity of soil (by ammonium acetate method) 

 

Principle :- 

 

Soil is first saturated with normal ammonium acetate (pH 7.0). Excess ammonium (NH4
+) ions 

and displaced cations are then removed by washing with alcohol. The amount of NH4
+ ions 

retained by the soil is measured by steam distillation of NH4-saturated soil with MgO. During 

distillation evolved ammonia is absorbed in a boric acid solution as ammonium borate and the 

amount a m m o n i u m  borate formed i s  determined by titration with standard sulphuric acid in 

presence of mixed indicator. 

 

Equipments and Materials 

 

Kjeldahl distillation set, shaker, Buchner funnel, Whatman No. 42 filter paper, balance, 800 ml 

Kjeldahl flask, 250 ml conical flask, 50 ml measuring cylinder. 

 

Reagents : 

 

 1N ammonium acetate (pH 7.0): Either dilute 57 ml of glacial acetic acid (99.5%) to 800 

ml with water containing 70 ml concentrated ammonia solution or dissolve 77.08g 

ammonium acetate (NH400CCH3) crystal in about 800 ml water. Cool and adjust pH to 7.0 

with dilute acetic acid or ammonia solution. Make up volume to 1 liter. 

 Ethanol, 60%: Dilute 630 ml of absolute alcohol (95%) to 1 liter with distilled water. 

 Ammonium chloride crystal 

 Magnesium oxide powder (MgO) 

 Mixed indicator: Dissolve 0.5 g bromo cresol green and 0.1 g methyl red in 100 ml of 95% 

ethanol. Adjust the solution to the bluish purple midcolour at pH 4.5 with dilute NaOH or 

HC1. This indicator is pink at pH 4.2 or lower and bluish green as pH rises to 4.9 and 

above. 

 Boric acid- indicator solution, 2%: Dissolve 20 g boric acid in about 800 ml hot distilled 

water. Cool, then add 20 ml of mixed indicator and adjust the pH of the solution by dilute 

NaOH or HCl until the bluish colour of the indicator weakens toward pink. Make up 

volume to 1 liter. 



 Standard sulphuric acid, O.'IN: Dilute 2.8 rnl of concentrated sulphuric acid to I liter with 

distilled water and standardize against standard sodium carbonate (0.1 N) using methyl red 

indicator. 

 Methyl red indicator, 0.5%: Dissolve 0.5 g indicator in 100 mi of 05% ethanol. 

 Silver nitrate solution, 0.1 M: Dissolve 8.5 g silver nitrate (AgN03) in 500 ml distilled 

water and add 2 ml concentrated HNO3 to it. 

 

Procedure 

 Take 10 g air dry processed soil in a 250 ml conical flask and add 50 ml of 1 N ammonium 

acetate solution. 

 Shake the suspension for an hour and leave it for overnight. 

 Filter the content through Whatman No. 42 filter paper fitted on Buchner funnel under 

suction. Transfer the soil completely to the filter paper. 

 Leach the soil with neutral normal ammonium acetate solution for about ten times. Before 

adding fresh aliquot (20 ml) allow the leachate to be drained out completely. 

 Leachate is preserved for determination of individual exchangeable cations.The soil left on 

the filter paper will be required for CEC determination. 

 Wash the soil with 60% ethanol to remove excess ammonium acetate. To be confirmed add 

a pinch of ammonium chloride to the soil on the filter paper and continue washing until the 

leachate becomes free from chloride (test with AgN03). 

 Transfer the soil with filter paper to an 800 ml distillation flask; add about 200 ml of water, 

little liquid paraffin and one spoonful of MgO. 

 Distill and collect ammonia by absorbing in 50 ml of 2% boric acid mixed indicator 

solution taken in a 250 ml conical flask. Collect about 150 ml distillate. 

 Titrate the distillate with standard sulphuric acid (0.1N) till pink colour appears. 

 Run a blank distillation in a similar way without soil. 

 

Calculations 

Say, 

Weight of soil taken = W g 

Volume of standard sulphuric acid required for sample titration — Vs ml 



Volume of standard sulphuric acid required for blank dtiation -VBml 

Strength (N) of standard sulphuric acid - S 

Cation exchange capacity, meq/100g = (Vs - VB) x S x (100/W) 

[As 1000 ml 1 N of any acid or alkali =1 equivalent of any cation  

Or 1 ml 1 N of any acid or alkali = 1 milliequivalent of any cation] 

Rating 

 

Soil Class on CEC CEC (meq/100 g soil) 

Low <10 

Medium 10-25 

High 25-45 

Very high >45 

 

 

Result 

 

Questions : 

1. Define CEC, Explain factors affecting it. 

2. Explain the significance of soil CEC in agriculture. 

3. Describe the role of Neutral normal ammonium acetate and 60% alcohol in determination CEC. 

 

Reference: 

1. Laboratory manual for agricultural chemistry – A.Sankaram. Methods of soil analysis (1965) Part-II 

Ed. C.A. Blank, American Society of Agronomy Madison, U.S.A. 

 

Reference URL 

 https://www.youtube.com/watch?v=7rMmH5PI93Q&t=380s 

  

https://www.youtube.com/watch?v=7rMmH5PI93Q&t=380s


Estimation of organic carbon and organic matter content in soil (Walkley and Black's 

method) 

 

Principle 

 

The organic carbon in organic matter is oxidized by known but excess of chromic acid 

(K2Cr2O7 + H2SO4). The excess chromic acid not reduced by organic matter is determined by 

back titration with std. FeSO4 solution (redo titration), using diphenylamine or Ferroin indicator. 

The organic carbon content in soil is calculated from the chromic acid utilized (reduced) by it. 

 

Reagents 

1. Potassium dichromate solution 1N : Dissolve 49.04 g of dried regent grade potassium 

dichromate in distilled water and dilute to 1 liter. 

2. Ferrous sulphate solution (0.5 N) : Dissolve 139g of reagent grade FeSO47H2O in 

distilled water and add 15 ml of concentrated H2SO4 cool and dilute to 1 liter.  Ferrous 

ammonium sulphate Fe(NH4)2(SO4)2.6H2O can also be used by dissolving 196.19 g of 

salt in 800 ml of water containing 20 ml of concentrated H2SO4 and making up to one 

liter and standardize the solution. 

3. Diphenyl amine indicator: Dissolve 0.5 g of DPA in 100mL of conc. H2SO4. 

4. Concentrated sulphuric acid : (Note less than 96%) 

5. Phosphoric acid H3PO4 (85%) 

6. Sodium fluoride NaF, (Solid). 

 

Procedure 

Transfer without loss 1g of soil sample finely ground and passed through 0.5 mm sieve 

into 500 ml Erlenmeyer flask. Add by means of a pipette 10 ml of 1 N Potassium dichromate 

solution and swirl the flask gently. Add 20 ml of conc. H2SO4 by measuring cylinder. Swirl the 

flask by hand for a minute or two and set aside on an asbestos pad for exactly half an hour. At 

the end of half an hour, add 200 ml of distilled water, 10 ml of H3PO4, 0.2 g of NaF and 1 ml of 

diphenylamine indicator and shake the content of flask. Titrate the contents of flask against 0.5 N 

ferrous sulphate or famous ammonium sulphate solution till the violet blue color changes to 

green. Note the burette reading at this point. 

 



Reactions  

Oxidation 

i. 2K2Cr2O7 + 8H2SO4 ---------- 2K2SO4 +2Cr2(SO4)3 + 8H2O + 60 

ii. 3C + 60 = 3CO2 

iii. K2Cr2 O7 + 6FeSO4 + 7H2SO4 ---------- K2SO4 + Cr2(SO4)3 + 7H2O 

Observation table to be recorded 

 

Sr. No. Observations Value 

1. Name of the soil  

2. Wt. of soil taken  

3. Wt. of oven dry soil  

4. Vol. of 1 NK2Cr2O7 added  

5. Vo1. of 0.5 N FeSO4 required for Blank (B)  

6. Vo1. of 0.5 N FeSO4 required for sample (T)  

 

Calculations 

       100 
Percent organic carbon = (B – T) x N x 0.003 x -------------- 

      Wt. of soil (oven dry) 

 

In this method recovery of organic carbon is 77% hence a correction factor of 100/77 

= 1.3 is used to get correct value. (Express results on oven dry basis) 

Percent organic matter = % organic carbon x 1.724. 

 

Rating of soil for organic carbon : 

 
1. Very low Less than 0.20% 

2. Low 0.21 to 0.40% 

3. Moderate 0.41 to 0.60% 

4. Moderately high 0.61 to 0.80% 

5. High 0.81 to 1.00% 

6. Very high Greater than 1.0% 

 

Result 

 



 

Questions 

1. Explain the principle involved in the estimation of organic carbon determination by Walk 

Ely and Black method. 

2. Explain the role of the following regents in the estimation of organic carbon. 

a) K2Cr2O7 b) Ferrous sulphate c) Conc. H2SO4 

3.  Why per cent of organic carbon is multiplied by 1.724 to get per cent of organic 

matter? 

4. Why is it necessary to multiply 1.3 to get exact amount organic carbon in soil? 

5. Which indicator is used in organic carbon estimation? 

 

References 

1. Jackson, M.L.   (1967).   Soil Chemical Analysis. Prentice Hall of India, New 

Delhi, pp. 214-221. 

2. Khanna, S.S. and D.V. Yadav, (1979). Practical Manual for introductory 

Courses in Soils. HAU, Hisser. 

3. Hesse.P.R. (1971). A Text of Soil Chemical Analysis. John Murray, Publ Ltd. 50 Albemarle 

Street, London, WLX-4BD. 

 

Reference URL 

 https://www.youtube.com/watch?v=JCQxGqD--GE 

 

  

https://www.youtube.com/watch?v=JCQxGqD--GE


Estimation of Mineralizable Nitrogen in Soil (Subbiah and Asija, 1956) 

 

Principle: 

The easily mineralizable nitrogen is estimated using alkaline KMnO4, which oxidizes the 

organic matter present in the soil and hydrolyzes the liberated ammonia which is condensed and 

absorbed in boric acid, and titrated against standard acid. The method has been widely adopted to 

get a reliable index of nitrogen availability in soil due to its rapidity and reproducibility. The 

process of oxidative hydrolysis is, however, a progressive one and hence a uniform time and 

heating temperature should be allowed for best results. Use of glass beads checks bumping while 

liquid paraffin checks frothing during heating. 

Apparatus:  

a) Nitrogen distillation unit or Kelplus distillation unit.  

b) Distillation tube, conical flasks, pipettes, burette etc. 

Reagents:  

1) 0.32% KMnO4: Dissolve 3.2 g of KMnO4 in distilled water and make the volume to one 

litre.  

2) 2.5% NaOH: Dissolve 25 g of sodium hydroxide pellets in water and make the volume to one 

litre.  

3) 2% Boric acid: Dissolve 20 g of boric acid powder in warm water by stirring and dilute to 

one litre.  

4) Mixed Indicator: Dissolve 0.066 g of methyl red and 0.099 g of bromocresol green in 100 

mL of ethyl alcohol. Add 20 mL of this mixed indicator to each litre of 2% boric acid 

solution.  

5) 0.1M Potassium Hydrogen Phthalate: Dissolve 20.422 g of the salt in distilled water and 

dilute to one litre. This is a primary standard and does not require standardization.  

6) 0.02M H2SO4: Prepare approximately 0.1M H2SO4 by adding 5.6 mL of conc. H2SO4 to 

about one litre of distilled water. From this, prepare 0.02M H2SO4 by diluting a suitable 



volume (20 mL made to 100 mL) with distilled water. Standardize it against 0.1M NaOH 

solution.  

7) 0.1M NaOH: Dissolve 4g NaOH in 100 mL distilled water. Standardize against potassium 

hydrogen phthalate. 

Procedure: 

1) Measure 20 mL of 2% boric acid containing mixed indicator in a 250 mL conical flask and 

place it under the receiver tube. Carefully dip the receiver tube in the boric acid solution.  

2) Take 2.5 g of soil sample in a 350mL distillation tube (run a blank without soil in a 350 mL 

distillation tube before started sample).  

3) Moisten the soil with about 10 mL of distilled water, wash down the soil, if any, adhering to 

the neck of the flask.  

4) Add 25 mL (Soil:0.32% KMnO4::1:5) of 0.32% of KMnO4 solution in the distillation tube 

manually or instrumentally.  

5) Add a few glass beads or broken pieces of glass rod.  

6) Add 2-3 mL of paraffin liquid, avoiding contact with upper part of the neck of the flask.  

7) Add 25 mL of 2.5% NaOH solution and immediately attach to the rubber stopper fitted in the 

alkali trap.  

8)  Press the run switch and continue distillation until about 100 mL of distillate is collected.  

9) First remove the conical flask containing distillate and then remove the distillation tube to 

avoid back suction.  

10) Titrate the distillate against 0.02M H2SO4 taken in burette until pink colour starts appearing.  

11) Carefully remove the distillation tube and drain the contents in the sink. 

**If brown colour not appearing in distillation tube at the time of distillation (after 6-7 min) 

then add 5-10 mL of 2.5% NaOH solution 

Precautions:  

a) Check the tap water and distilled water.  

b) Dip the delivery tube end in the receiver containing standard boric acid solution before adding 

NaOH solution in the distillation flask.  



c) Close the distillation tube to the distillation apparatus tightly then add NaOH to avoid the loss 

of ammonia.  

d) During distillation, first remove the receiver flask and then distillation tube.  

e) Collect about 100 mL of distillate in 10 minutes steady distillation. 

 

Observation: 

Sl No. Initial burette reading 

(mL) 

Final burette reading 

(mL) 

mL of (0.02N H2SO4) 

    

    

 

Calculation:  

Mineralizable N (kg/ha) = Volume of acid used to neutralize ammonia in the sample = (A – B) 

mL  

Where,  

A = Volume of 0.02N H2SO4 used in titration of soil sample against ammonia absorbed in boric 

acid. 

 B = Volume of 0.02N sulphuric acid used in blank titration.  

N= Normality of sulphuric acid  

1 mL of 0.02N sulphuric acid = 0.56 mg N (1000 mL of 1N H2SO4 = 14 g Nitrogen).  

**[ Rating: Low = < 280 kg/ha, Medium= 280-560 kg/ha, High= > 560 kg/ha] 

Result:  

The available nitrogen status of the soil is _________ kg /ha. 

Video Link: 

https://www.youtube.com/watch?v=l10NBPglZzI 

 

 

https://www.youtube.com/watch?v=l10NBPglZzI


 Estimation of Available Phosphorus in Acid Soil 

Principle: 

In soil, phosphorus exists in the form of various types of orthophosphates. A very small fraction 

of these is available to plants at a given time. Available phosphorus content of soil consists 

mainly of Ca-, Al-, and Fe-P. In the neutral and alkaline soils particularly, Ca-P is the dominant 

fraction. Organic -P fraction is also in considerable amount, but is usually not included in the 

determination of available phosphorus. A large number of extraction reagents from Dyer’s 1% 

citric acid to some of the multi nutrient extractants, buffer solutions, acids and chelating agents 

have been suggested for available phosphorus from time to time. However, no single extractants 

appears to be suitable for all types of soils. Two types of extraction methods are more popularly 

adopted. Under acidic conditions, Bray’s P-1 (or Bray No. 1), which involves soil extraction with 

a solution consisting of 0.03 (N) NH4F and 0.025 (N) HCl is widely followed. The fluoride 

complexes Al and Fe in soil, thus releasing some bound P besides the easily acid soluble P 

(largely Ca-P). This extractant is suitable for soils containing less than 2% calcite or dolomite 

because in calcareous soils, carbonates quickly neutralize the acid, resulting in less extraction of 

P. 

Bray’s P-1 (Bray and Kurtz, 1945) 

Apparatus and Instruments:  

a) Spectrophotometer  

b) Shaker 

c) Pipettes  

d) Beakers  

e) Conical flasks  

f) Volumetric flasks  

Reagents: 

1. Bray Extractant No 1 (0.03M NH4F in 0.025M HCl): Dissolve 1.11 g of NH4F (AR) in one 

litre of 0.025N HCl.  



2. Dickman Bray's reagent (Molybdate reagent): Dissolve 15.0 g (NH4)2MoO4 in 300 mL 

warm distilled water, cool and add the solution to 350 mL of 10 N HCl solution gradually 

with stirring. Dilute to one litre with distilled water.  

3. Stannous chloride solution (40 % Stock Solution): Dissolve 10 g SnCl2.2H2O in 25 mL of 

concentrated HCl. Add a piece of pure metallic tin and store the solution in a glass stoppered 

bottle. 

4. Stannous chloride solution (Working Solution): Dilute 1 mL of the stock solution of 

stannous chloride to 66.0 mL with distilled after just before use. Prepare fresh dilute solution 

every working day.  

Preparation of the Standard Curve:  

 

Dissolve 0.439 g of pure dry KH2PO4 in about half a litre of distilled water. About 25 mL 7N 

H2SO4 is added and made up to one litre with distilled water. This solution contains 100 ppm 

stock solution of P (100 mg P /L). Preserve this as a stock standard solution of phosphate. From 

this, a 2 ppm P 12 solution is made. Take 0,1, 2, 3, 4, 5 and 6 mL of this 2ppm solution to 25 mL 

volumetric flasks. To these 5 mL of extracting reagent (Bray's) is added as described above by 

adding Bray's No. 1, 5 mL of Dickman Bray's reagent, 1 mL SnCl2 and make the volume with 

distilled water and take reading as per sample readings. 

Procedure:  

a) Take 2.5 g of soil and 25 mL of the Bray's reagent (1:10 Soil: Solution) are shaken for 5 

minutes in 250 mL conical flask and filtered.  

b) Take 5 mL of the filtered soil extract with a bulb pipette in a 25 mL volumetric flask. To 

avoid interference of fluoride 7.5 mL of 0.8 M boric acid (50g H3BO3 per litre) can be 

added to 5 mL of the extract.  

c)  Add 5 mL of the molybdate reagent and add about 10 mL distilled water, shake and add 

1 mL of the dilute SnCl2 solution with a pipette. Make up the volume with distilled water 

and shake thoroughly.  

d)  Read the blue colour after 10 minutes on the spectrophotometer at 660 nm wavelength 

after setting the instrument to zero with the blank prepared similarly. 



e) **Phosphorus is determined spectrophotometrically by Dickman and Bray's (Dickman 

and Bray, 1940) method. 

 

  



Estimation of Available Phosphorus in Alkaline soil 

Principle: 

The other and most widely used extractant is the 0.5 (M) NaHCO3 solution at pH 8.5. The 

reagent is most suitable for neutral to alkaline soils and is designed to control the ionic activity of 

calcium through solubility product of CaCO3, thus extracting the most reactive forms of P from 

Al-, Fe-, and Ca- phosphates. Phosphorus in the extract can be determined using suitable method 

of colour development and measuring the colour intensity at an appropriate wavelength. 

Olsen’s Method (Olsen et al., 1954) 

Apparatus and Instruments:  

a) Spectrophotometer  

b) Shaker 

c) Pipettes  

d) Beakers  

e) Conical flasks  

f) Volumetric flasks  

Reagents:  

a) 0.5 M NaHCO3: Dissolve 42 g Sodium bicarbonate in 1 litre of distilled water and adjust 

the pH to 8.5 by addition of dilute NaOH or HCl. Filter it, if necessary.  

b) Activated carbon –Darco G 60 or P free charcoal.  

c) Molybdate reagent: Same as for the Bray’s Method No. 1 except that use 400mL of 10 N 

HCl instead of 350 mL/litre.  

d) Stannous chloride solution: Same as in Bray’s Method No. 1. 

Preparation of the Standard Curve:  

Dissolve 0.439 g of pure dry KH2PO4 in about half a litre of distilled water. About 25 mL 7 N 

H2SO4 is added and made up to 1 litre with distilled water. This solution contains 100 ppm stock 

solution of P (100 mg P /L). Preserve this as a stock standard solution of phosphate. From this, a 

2 ppm P solution is made. Take 0,1, 2, 3, 4, 5 and 6 mL of this 2-ppm solution to 25 mL 

volumetric flasks. To these 5 mL of extracting reagent (Olsen's) is added as described above by 



adding, 5 mL of molybdate reagent (for Olsen's method), 1 mL SnCl2 and make the volume with 

distilled water and take the colour reading on the spectrophotometer at 660 nm wavelength. Plot 

the absorbance reading against P mg/L and prepare the standard curve by adjoining points. 

Procedure:  

1) Weigh 2.5 g soil sample in a 250 mL conical flask.  

2) Add 1-2 g of Darco G 60 or P free charcoal and 50 mL of the bicarbonate extractant (0.5M 

NaHCO3, pH8.5).  

3) Shake for 30 minutes on the mechanical shaker and filter through Whatman No. 42 filter paper.  

4) Transfer 5 mL of filtrate in to 25 mL volumetric flask and gradually add 5 mL of ammonium 

molybdate containing 400 mL of 10 N HCl.  

5) Stir slowly and carefully to drive out the CO2 evolved.  

6) After stop of bubbliness, add distilled water washing down the sides and bring the volume to 22 

mL 

7) Add 1 mL of freshly prepared diluted SnCl2, shake a little and make up the volume.  

8)  Run a blank without soil in similar manner.  

9) Read the blue colour after 10 minutes on the spectrophotometer at 660 nm wavelength (or red 

filter for colorimeter) after setting the instrument to zero with the blank prepared similarly. 

Precautions:  

a) Clean all glassware with distilled water.  

b) Start filtration quickly after shaking  

c) Before taking reading, warm up the instrument minimum 30 min.  

d) Take reading after 10 min. 

Observation: 

Sl No. Spectrophotometer reading (Abs) 

  

  



  

  

 

 

Calculation: 

 Available P (kg/ha) = R × dilution factor × 2.24  

Where,  

R = ppm P in the sample (read from standard curve)  

Dilution factor = 50/2.5 × 25/5 = 100 (Weight of the soil taken = 2.5 g,  

Volume of the extract = 50 mL;  

Volume of the aliquot taken for estimation = 5 mL and  

Volume made for estimation (dilution = 5 times) = 25 mL) 

 

Rating: 

P kg/ha Low Medium High 

Bray’s Method < 30 30-60 >60 

Olsen’s Method < 15 15-30 >30 

Conversion factor: P × 2.29 = P2O5 

Result:  

The available phosphorus status of the soil is _______ kg /ha 

Video link: 

https://www.youtube.com/watch?v=y2FsPH5ZDXY 

https://www.youtube.com/watch?v=R1lFrMjoraE 

https://www.youtube.com/watch?v=R1lFrMjoraE


Estimation of available Potassium in Soils (Jackson, 1973) 

Principle: 

Potassium in soil exists as water soluble, exchangeable, non-exchangeable (fixed) and lattice-K. 

The first two forms constitute only a small part, normally not more than 1% of the total content 

and are considered to be easily available to plants. On amount basis, the exchangeable form (K+ 

ions adsorbed on exchange sites) far exceeds water-soluble fraction and the two are in 

equilibrium with each other. Only when these two forms are depleted, a part of the non-

exchangeable K moves to the exchange sites and soil solution. This movement is a slow process 

and not sufficient to meet K requirement of plants. Therefore, most of the methods suggested are 

based on the determination of easily available fractions ie. water soluble and exchangeable K. 

attempts, however have been made to include a part of the non-exchangeable fraction in certain 

methods to increase the prediction value. Thus, methods for both available and non-

exchangeable k have been in use. For all practical purpose, the extraction and estimation of 

exchangeable K along with water soluble K is good enough. The ammonium ions are very close 

in size to K+ and replace the latter efficiently. During the estimation, accurate burns clearly and 

does not leave any residue on the burner of the flame photometer. 

Instruments:  

a)  Flame Photometer  

b) Glass electrode pH meter 

Reagents:  

1. 1(N) ammonium acetate solution: Dissolve 77.08 g of ammonium acetate (NH4C2H3O2) 

in about 800 mL of distilled water and adding to its 57 mL of glacial acetic acid and 68 

mL of ammonium solution (sp.gr. 0.91) followed by dilution to one litre and adjusting pH 

7.0 after cooling.  

2. Standard potassium solution: Dissolve 1.908 g pure KCl (oven dried) in one litre of 

distilled water. This solution contains 1000 mg KCl. Dilute suitable volumes of this 

solution to get 100mL of working standards containing 0, 5, 10, 15, 20, 25 and 30 mg 

KCl. The working standards should be making up the volume with ammonium acetate 

solution. 



 

Procedure:  

a) Weigh 5 g of soil sample in 250 mL conical flask and add 25 mL of 1 N ammonium 

acetate solution and shake for 5minutes.  

b) Filter through Whatman No. 1 filter paper.  

c) Measure K concentration in the filtrate flame photometer. 

Preparation of the Standard Curve:  

Set up the flame photometer by atomizing 0 and 20 mg K/mL solutions alternatively to 0 and 

100 reading. Atomize intermediate working standard solutions and record the readings. Plot 

these readings against the respective potassium contents and connect the points with a straight 

line to obtain a standard curve. 

Precautions:  

1. Start filtration quickly after shaking 

2. Before taking reading, warm up the instrument minimum 30 min 

3. Check the flame level 

Observation: 

Sl No. Flame photometer Reading (ppm) 

  

  

  

 

Calculation:  

K (kg/ ha) = R × dilution factor × 2.24 

Where, 



 Dilution factor = 25/5 (1:5:: Soil : Solution) 

R = content of K (mg) in the sample, as read from the standard curve.  

**[Rating (K kg/ha): Low = < 120 kg/ha, Medium= 120-280 kg/ha, High= > 280 kg/ha Conversion 

factor: %K × 1.2047 = %K2O] 

Result:  

The available potassium status of the soil is __________ kg /ha. 

Video link: 

https://www.youtube.com/watch?v=IxK_I-Q2e8w 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



 

Estimation of available Ca and Mg in Soils 

Principle: 

The method described here was developed by Lavkulich (1981) for standard analysis of a wide 

range of soil types. It involves fewer steps than some other similar methods such as that of Mc 

Keague (1978). Problems with this approach to measuring exchangeable cations and CEC have 

been discussed extensively in the literature (Chapman 1965; Bache 1976; Rhoades 1982; 

Thomas 1982) but we agree with the conclusion of Thomas (1982) that ''there is no evidence at 

the present time that cations other than NH4
+ give results that are less arbitrary than those 

obtained using NH4
+.'' Errors due to the dissolution of CaCO3 and gypsum will result in an 

excess of Ca2+ being extracted by NH4+ and a decrease in the amount of NH4
+ retained due to 

competition between Ca2+ and NH4
+ during equilibration in the saturating step. In soils 

containing these minerals, exchangeable Ca will be too high and total CEC too low. The former 

problem cannot easily be corrected (Thomas 1982); however, more accurate measurement of 

CEC in this type of soil can be obtained by using the method described by Rhoades (1982). 

Fixation of K+ and NH4 
+ in phyllosilicates can result in either an over- or underestimation of 

exchangeable K+ when NH4 
+ is used as an extractant depending on whether the NH4 

+ moves 

through the interlayer positions replacing the K+ or whether it causes the collapse of the edges 

preventing further exchange. Compared to the other methods presented in this chapter, this 

method uses a larger sample size, which helps to decrease the sample to sample variability. 

Another advantage of this procedure is that there are no decantation steps that can cause the loss 

of sample, particularly in the case of organic soils. The method described below can be used to 

measure either exchangeable cations and CEC or just exchangeable cations. In the latter case, the 

sum of exchangeable cations (including Al) could be 26 used as an estimate of CEC. Due to the 

high pH of the extracting solution, the amount of Al measured will usually be lower than that 

displaced by BaCl2 or KCl. 

1. Calcium by Versenate (EDTA) method: 

Apparatus: 

a) Shaker 



b) Porcelain dish 

c) Beakers  

d) Volumetric/conical flask 

Reagents:  

a) Ammonium chloride: Ammonium hydroxide buffer solution: Dissolve 67.5 g ammonium 

chloride in 570 ml of conc. ammonium hydroxide and make to 1 litre.  

b) Standard 0.01N calcium solution: Take accurately 0.5 g of pure calcium carbonate and 

dissolve it in 10 ml of 3N HCl. Boil to expel CO2 and then make the volume to 1 litre 

with distilled water.  

c) EDTA solution (0.01N): Take 2.0 g of versenate, dissolve in distilled water and make the 

volume to 1 litre. Titrate it with 0.01N calcium solution and make necessary dilution so 

that its normality is exactly equal to 0.01N. 

d) Muroxide indicator powder: Take 0.2 g of muroxide (also known as ammonium 

purpurate) and mix it with 40 g of powdered potassium sulphate. This indicator should 

not be stored in the form of solution, otherwise it gets oxidized.  

e) Sodium diethyl dithiocarbamate crystals: It is used to remove the interference of other 

metalions.  

f) Sodium hydroxide 4 (N): Prepare 16% soda solution by dissolving 160 g of pure sodium 

hydroxide in water and make the volume to 1 litre. This will give pH 12. 

Procedure:  

1. Take 5 g air dried soil sample in 150 ml conical flask and add 25 ml of neutral normal 

ammonium acetate. Shake on mechanical shaker for 5 minutes and filter through 

Whatman No.1 filter paper.  

2. Take a suitable aliquot (5 or 10 ml) and add 2-3 crystals of carbamate and 5 ml of 16% 

NaOH solution.  

3. Add 40-50 mg of the indicator powder. Titrate it with 0.01N EDTA solution till the 

colour gradually changes from orange red to reddish violet (purple). It is advised to add a 

drop of EDTA solution at an interval of 5 to 10 seconds, as the change of colour is not 

instantaneous.  



4. The end point must be compared with a blank reading. If the solution is over titrated, it 

should be back titrated with standard calcium solution and exact volume used is thus 

found.  

5. Note the volume of EDTA used for titration. 

 

 

Observation: 

Sl. No. Initial burette reading 

(mL) 

Final burette reading 

(mL) 

Final volume (mL) 

    

    

    

 

Calculation: 

If N1 is normality of Ca2+ and V1 is volume of aliquot taken and N2V2 are the normality and 

volume of EDTA used, respectively, then 

N1V1 = N2V2 

Or, N1 = N2V2/V1 =Normality of EDTA X Volume of EDTA/ml of aliquot taken 

Hence, N1 (Normality) = equivalent of Ca2+ present in one litre of aliquot 

Hence, Ca2+ (me/litre) = Normality of EDTA X Volume of EDTA X 1000/ ml of aliquot taken 

When expressed in soil weight basis, 

Ca2+ me/100g soil = 100/wt. of soil X extract volume/1000 X Ca as me/litre 

 

Result:  



The Ca content in soil is ______ me/100 g soil. 

 

Video link: 

https://www.youtube.com/watch?v=hTy9JBllUVg 

 

 

2. Calcium plus Magnesium by Versenate (EDTA) method 

Magnesium in solution can be titrated with 0.01N EDTA using Eriochrome black T dye as 

indicator at pH 10 in the presence of ammonium chloride and ammonium hydroxide buffer. At 

the end point, colour changes from wine red to blue or green. When calcium is also present in the 

solution this titration will estimate both calcium and magnesium. Beyond pH 10 magnesium is 

not bound strongly to Erichrome black-T indicator to give a distinct endpoint. 

Apparatus: 

a) Shaker  

b) Porcelain dish 

c) Beakers 

d) Volumetric/conical flask 

Reagents:  

1. EDTA or Versenate solution (0.01N): Same as in calcium determination.  

2. Ammonium chloride ammonium hydroxide buffer solution: Same as in calcium 

determination. 

3. Eriochrome black T indicator: Take 100 ml of ethanol and dissolve 4.5 g of hydroxyl 

amine hydrochloride in it. Add 0.5 g of the indicator and prepare solution.  

4. Hydroxylamine hydrochloride removes the interference of manganese by keeping it in 

lower valency state (Mn2+). Or mix thoroughly 0.5 g of the indicator with 50 g of 

ammonium chloride.  



5. Sodium cyanide solution (2%) or sodium diethyl dithiocarbamate crystals: This is used to 

remove the interference of copper, cobalt and nickel. 

Procedure:  

a) Take 5 g air dried soil in 150 ml flask, add 25 ml of neutral normal ammonium acetate 

solution and shake on a mechanical shaker for 5 minutes and filter through Whatman 

No.1 filter paper.  

b) Pipette out 5 ml of aliquot containing not more than 0.1 me of Ca plus Mg. If the solution 

has a higher concentration, it should be diluted.  

c) Add 2 to 5 crystals of carbamate and 5 ml of ammonium chloride-ammonium hydroxide 

buffer solution. Add 3-4 drops of Eriochrome black-T indicator.  

d)  Titrate this solution with 0.01N versenate till the colour changes to bright blue or green 

and no tinge of wine-red colour remains. 

Calculation: 

If N1 and V1 are normally (concentration of Ca2+ and Mg2+) and volume of aliquot taken and 

N2V2 are the normality and volume of EDTA used respectively, then 

N1V1 = N2V2 

Or, N1 = N2V2/V1 = Normality of EDTA X Volume of EDTA/ ml of aliquot taken 

Here, N1 (Normality) = equivalents of Ca2+ plus Mg2+ me/litre = Normality of EDTA X Volume 

of EDTA X 1000/ ml of aliquot taken 

Milliequivalent (me) of Mg2+ = me (Ca2+ + M2+) – me of Ca2+ 

When expressed on soil weight basis 

Ca2+ + Mg2+ me/100g soil = 100/wt. of soil X extract volume/ 1000 X Ca2+ + Mg2+ me/litre  

Observation: 

Sl No. Initial burette reading 

(mL) 

Final burette reading 

(mL) 

Final volume (mL) 



    

    

    

 

Result:  

The Ca + Mg content in soil ________ me/100 g soil 

Video link: 

https://www.youtube.com/watch?v=yDGMgYwHoVA 

 

 

 

  



Estimation of Available Sulphur in Soils 

Principle: 

Besides some amount in the soil solution, available sulphur in mineral soils mainly adsorbed 

SO42- ions. Both CaCl2 and phosphate solutions (as monocalcium phosphate) are generally used 

for replacement of the adsorbed SO4
2- . Use of Ca salts have a distinct advantage over those Na 

or K, as Ca prevents deflocculation in heavy textured soils and leads to easy filteration. SO42- in 

the extract can be estimated turbidimetrically using a colorimeter/ spectrophotometer/ 

autoanalyzer. A major problem arises when the amount of extracted sulphur is too low to be 

measured precisely.  

Apparatus and Instruments:  

a) Spectrophotometer  

b) Mechanical Shaker 

c) Conical flasks  

d) Volumetric flask 

Reagents:  

1. 0.15% CaCl2: Take 1.5 g CaCl2 in a volumetric flask and makeup volume 1000 mL mark 

with distilled water.  

2. Sodium acetate acetic acid buffer (pH 4.8) [CH3COONa-CH3COOH]: 1000 mL 

volumetric flask add 100 g sodium acetate, add distilled water 500 mL to mixed, add 30 

mL 99.5% acetic acid, shake to dissolved sodium acetate the makeup volume 1000 mL 

mark.  

3. 0.25% Gum acacia solution: Dissolve 0.25g of chemically pure gum acacia powder in 

100 mL of hot water and filter in hot condition through Whatman No.42 filter paper. 

Cool and and keep in refrigerator. 

4. Barium chloride crystal AR grade (BaCl2.2H2O): Pass AR grade BaCl2 salt through 1 mm 

sieve and store for use.  

5. 100 ppm S solution: Take 0.5434 g of K2SO4 and add 500mL distilled water to dissolved 

then make up to 1000 mL mark of volumetric flask 



Procedure:  

a) Weigh 5 g soil sample in a 250 mL conical flask.  

b) Add 25 mL of 0.15%CaCl2.  

c) Shake with 230 rpm for 30 minutes on the mechanical shaker and filter through Whatman 

No. 42 filter paper.  

d) Transfer 10 mL of filtrate in to 25 mL volumetric flask and gradually add 10 mL of 

sodium acetate acetic acid buffer.  

e) Add 1 g BaCl2.2H2O powder and shake well.  

f) Then add 1mL gum acacia and make up the volume with distilled water.  

g) Run a blank without soil in similar manner.  

h)  Measure the turbidity intensity at 440 nm (blue filter).  

i)  Run a blank side by side. 

 

Preparation of standard curve: 

 Put 0, 1.25 2.5, 5.0, 7.5, 10.0, 12.5, 15.0 mL of the working standard solution (10 mg S/litre) 

into a series of 25 mL volumetric flasks to obtain 0, 0.5, 1.0, 2.0,3.0, 4.0, 5.0 and 6.0 ppm. 

Develop turbidity as described above for sample aliquots. Read the turbidity intensity and 

prepare the curve by plotting readings against sulphur concentrations. 

 

Precautions:  

1. Before taking reading, warm up the instrument minimum 30min 

2. Take reading within 30min 

Observation: 

Sl No. Spectrophotometer (Abs) 

  

  



  

  

 

Calculation:  

Available S in soil (mg/kg) = R × 25/5 × 25/10 = R × 12.5 

Where,  

R stands for the quantity of sulphur in mg as obtained on X-axis against an absorbance reading 

(Y-axis) on standard curve. 

5 is the weight of the soil sample in g and 25 is the volume of the extractant in mL. 10 is the 

volume of filtrate solution in mL in which turbidity is developed and make up the volume to 

25mL. 

 

Result:  

The available sulphur status of the soil is _________ mg/kg or ppm. 

Video link: 

https://www.youtube.com/watch?v=8FsnaWA1Jp4 

 

 

 

 

 

  



Estimation of Total Nitrogen in Plants (Kjeldahl method) 

Principle: 

Nitrogen mostly present in soil in organic form. Relatively small amount of nitrogen usually 

occurs in ammonium and nitrate form, the available form. The Kjeldahl method of total N 

determination includes both organic and ammonium form and with modification nitrate form of 

N can also be included.  

Plant samples for N determination are digested in sulphuric acid at a temperature below 360 and 

410oC. Below 360oC, the digestion process is very slow or incomplete but above 410oC some of 

the ammonia may be lost. The rate of digestion is accelerated by using copper sulphate as a 

catalyst and anhydrous sodium sulphate or potassium sulphate to raise the boiling temperature of 

H2SO4. The temperature of digestion is carefully regulated for best and complete digestion, 

which normally takes less than 2 hours. On completion of digestion, the samples are cooled and 

diluted as concentrated alkali is to be added to H2SO4 digest for distillation. The distilled 

ammonia is quantitatively adsorbed in boric acid and titrated against standard acid. 

Apparatus:  

1. Kelplus digestion and distillation unit.  

2. Distillation tube 

3. Conical flasks  

4. Burettes  

5. Pipettes  

Reagents:  

1. Sulphuric acid – H2SO4 (93-98%)  

2. 40% sodium hydroxide solution: Dissolve 350 g solid NaOH in water and dilute to one 

litre  

3. 4% Boric acid: Dissolve 40 g of boric acid powder in warm water by stirring and dilute to 

one litre 



4. Mixed Indicator: Dissolve 0.066 g of methyl red and 0.099 g of bromocresol green in 100 

mL of ethyl alcohol. Add 20 mL of this mixed indicator to each litre of 4% boric acid 

solution 

5. 0.2N H2SO4: Prepare approximately 0.2N acid solution and standardize against 0.1N 

sodium carbonate  

6. Salicyclic acid or Devarda’s alloy: Using for reducing NO3 to NH4
+, if present in the 

sample 

7. Digestion mixture: 10 g Potassium sulphate (K2SO4) or anhydrous sodium sulphate (AR 

grade) + 1 g catalyst mixture (20 parts of Copper sulphate [CuSO4.H2O (AR grade)] 

powder and 1part metallic selenium powder. 

Procedure:  

a) Take 1 g soil or 0.5 g plant/seed sample in distillation tube.  

b)  Add 3-5 g digestion mixture and add 10 mL concentrated H2SO4. 

c) Heat low temperature for 30 min. and then increased heat up to 410 °C and digest for 1-2 

h or until solution is crystal clear green colour and then stop the digestion. If necessary, 

add small amount of paraffin or glass beads to reduce frothing. 

d) Remove the flask from the heater and cool, add 50 mL water and transfer to distilling 

flask for distillation.  

e) At the time of distillation, add 30 mL of 40% NaOH in the distilling flask in such a way 

that the contents do not mix.  

f) The contents are distilled for 5 minutes by pressing run bottom of Kelplus distillation unit 

and the liberated ammonia collected in a conical flask (250 mL) containing 20 mL of 4% 

boric acid solution with mixed indicator.  

g) First remove the conical flask containing distillate and then remove the distillation tube to 

avoid back suction.  

h) Titrate the distillate against 0.2N H2SO4 taken in burette until pink colour starts 

appearing. 

i) Carefully remove the distillation tube and drain the contents in the sink. 

 



Precautions:  

1. The material after digestion should not solidify. 

2. No NH4 should be lost during distillation.  

3. If the indicator changes colour during distillation, determination must be repeated using 

either a smaller sample weight or a larger volume of standard acid. 

4.  Standard the 0.2N H2SO4 by using standard solution.  

5. Check the tap water and distilled water. 

6. Dip the delivery tube end in the receiver containing standard boric acid solution before 

adding NaOH solution in the distillation flask.  

7. Close the distillation tube to the distillation apparatus tightly then add NaOH to avoid the 

loss of ammonia. 

8. During distillation, first remove the receiver flask and then distillation tube. 

9. Collect about 100 mL of distillate in 10 minutes steady distillation. 

Observation: 

Sl No. Initial burette reading Final burette reading mL of (0.2N H2SO4) 

    

    

    

 

Calculation: 

N (%) = (A- B) X Normality of H2SO4 X 0.014 X 102/ Wt. of the sample 

Volume of acid used to neutralize ammonia in the sample = (A – B) mL  

Where, 

 A = Volume of 0.2N H2SO4 used in titration of soil sample against ammonia absorbed in boric 

acid. 

 B = Volume of 0.2N sulphuric acid used in blank titration. 

Normality of sulphuric acid = 0.2  

(1000 mL of 1N H2SO4 = 14 g Nitrogen). 



Protein Content:  

Crude protein was determined by multiplying percentage of nitrogen content in seeds of crops 

with a factor of 6.25 (Tai and Young 1974). 

 % Crude Protein = % N x 6.25 

Result:  

The total nitrogen content in seed/plant is _____________ %. 

Video link: 

https://www.youtube.com/watch?v=3uQOezl_Uos 

  



Estimation of Phosphorus in Plants 

Sample digestion for plant analysis of P, K and S: 

For the release of mineral elements from plant tissues, dry ashing and wet oxidation are the two 

widely adopted methods. Dry ashing is carried out usually at an ignition temperature of 550 to 

600oC followed by its extraction in dil. HCl or H2SO4 for determining various elements. Ashing 

at temperature exceeding 600oC leads to considerable volatilization loss of P and K. to prevent 

this loss of P, dry ashing is carried out in presence of an alkali like Mg (NO3) in alcohol. 

Volatilization loss of S and Cl also takes place during ignition, which can be prevented by 

adding Na2CO3. A part of P also gets occluded, causing lot of error. For these reasons and for 

being comparatively more time taking, dry ashing is only occasionally adopted. Wet oxidation 

employs oxidizing acids like HNO3- H2SO4- HClO4 tri- acid mixture or HNO3- HClO4 di- acid. 

Use of HClO4 avoids the volatilization loss of K and provides a clear solution while H2SO4 helps 

in completing oxidation. HClO4 on heating produces anhydrous HClO4 which dissociates into 

nascent chlorine and oxygen, increasing the oxidation efficiently at high temperature. Direct 

contact with HClO4 with plant samples might lead to explosion and fire, hence the pre-digestion 

of samples in HNO3 is preferred. Digestion with HNO3- HClO4 instead of the tri-acid mixture is 

also adopted specially when S is also to be determined in the same digest. 

Principle: 

Phosphorus in the aliquot can be determined using the methods based on molybdophosphoric 

blue colour developed by reduction of the hetero- poly complex or by vanadomolybdophosphoric 

yellow colour method. The vanadomolybdophosphoric yellow colour method is suitable for P 

determination in plant extracts. 

Apparatus:  

a) Spectrophotometer  

b) Volumetric flask 

c) Pipette  

d) Conical flasks 

e) Beaker  



 

Reagents:  

1. Triacid mixture: Look over the procedure of sample digestion 

2. Ammonium molybdate ammonium vanadate solution: Dissolve 22.5 g of (NH4)6 MO3O7 

.4H2O in 400 mL of distilled water in a beaker. Take 1.25 g of ammonium vanadate in 

another beaker, add 300 mL distilled water and boil it. Add ammonium vanadate solution 

to the ammonium molybdate solution and cool the contents. Add 250 mL of concentrated 

HNO3 and dilute it to 1 litre. 

3. Phosphate standard solution: Take 0.22 g of AR grade KH2PO4 in a beaker and dissolve 

in distilled water, transfer the solution to a 1 litre volumetric flask and make up the 

volume. This solution contains 50 ppm of P. 

Procedure:  

a) After digestion (see digestion of Seed and Plant samples), take 10 mL filtered solution 

into a 25 mL volumetric flask. Add 10 mL ammonium molybdate-ammonium vanadate 

solution and make the volume to 25 mL with distilled water. Yellow colour will develop 

after 15-20minutes.  

b) From the 50ppm standard solution of P pipette out 0, 2, 4, 6, 8 and 10 mL and transfer in 

50 mL volumetric flaks then add 10 mL of ammonium molybdate ammonium vanadate 

solution and make the volume. This will contain 0, 2, 4, 6, 8 and 10 ppm P.  

c) Measure the colour intensity of standard solutions at a wave length of 470 nm or by using 

blue filter in a Spectrophotometer. Prepare the standard curve by plotting concentration 

of P on X-axis and Spectrophotometer readings on Y-axis on a graph paper.  

d) Take readings of seed/plant samples in the similar manner that of standard. 

Precautions:  

1. The temperature of the digestion mixture during digestion should not exceed 2300C. 

2. The reading of the P in solution should be taken after 30 minutes from the development 

of yellow colour.  

3. Ammonium molybdate-ammonium vanadate solution should be stored in a coloured 

bottle to prevent oxidation. 



4.  A clear and white residue in flask should remain after digestion. In case of incomplete 

digestion, the material should be again digested after addition of 5 mL of triacid. 

Observation: 

Sl No. Spectrophotometer Reading (Abs) 

  

  

  

 

Calculation:  

P (mg/kg) in plant sample = R × d.f.  

Where,  

R = ppm reading of plant from standard curve 

Dilution factor (d. f.) = Volume of extractant/ Weight of soil X Final volume of solution/ 

Volume of digest extract  

                                   = 100 X 25/ 0.5 X 10 = 500 

Where,  

Weight of plant sample = 0.5 g, Volume of digested extract prepared = 100 mL, Volume of 

digested extract taken = 10 mL, Volume of final coloured extract prepared = 25 mL 

Results:  

P content in sees/plant _______ mg/kg.  

** % P = P ppm / 10000 

Video link: 

https://www.youtube.com/watch?v=y2FsPH5ZDXY 

 

 



Estimation of Potassium in Plants 

Principle: 

Potassium in the acid digest of plant samples can be determined using flame photometer. 

Depending on the concentration of K in the plant sample, the digest can be used either directly or 

after dilution foe flame photometric determination.  

Apparatus: 

a)  Flame photometer 

b) Volumetric flask 

c) Pipette 

d) Beaker 

e) Conical flask  

f) Funnel  

g) Hot plate  

Reagents: 

1. Triacid digestion: see digestion of Seed and Plant samples. 

2. Potassium standard solution: Dissolve 1.9103 g of AR grade KCl in distilled water. Transfer 

it to 1 litre volumetric flask and make the volume. This solution contains 1000 ppm of K. To 

prepare 100 ppm solution takes 10 mL of 100 ppm K solution in a 100 mL volumetric flask 

and make up its volume. 

Procedure:  

a) Digest the plant sample with triacid as per the method given in digestion of Seed and 

Plant samples and filtered the solution and make the volume in 100 mL volumetric flask.  

b) Prepare 0, 2, 4, 6, 8 and 10 ppm K solution by taking 0, 2, 4, 6, 8 and 10 mL of 100 ppm 

K solution in 100 mL flask respectively and making up their volume.  

c) Feed the standard in flame photometer and standardized the instrument on low and high 

level of K content and then take the readings in ppm of K content.  

d)  If the readings of sample are showed over calibration then dilute the extract 5 to 10 times 

or more as required. 



Precautions:  

1. Extract should be clear and it should be prepared from double distilled water otherwise it 

clogs the sucking capillary.  

2. The air pressure should be maintained steadily at 0.48 kg/cm2 to get uniform flame and 

proper atomization. 

3.  Do not feed K solutions having higher concentration than that prescribed for the 

instrument.  

4. Be sure that the filter used in flame photometer is of potassium.  

5. After taking 8-10 readings feed distilled water and then again take the 43 sample 

readings. 

6. After completion of reading close the gas then after some time stop the air supply. 

Observation: 

Sl No. Flame Photometer Reading (ppm) 

  

  

  

 

Calculation:  

K (mg/kg) content in seeds/plant = R × d.f  

Where,  

R = ppm reading of from standard curve 

Dilution Factor (d. f.) = Volume of extractant/ Volume of digested extract 

                                       = 100/ 0.5 = 200 

Where,  

Weight of plant sample = 0.5 g,  



Volume of digested extract prepared = 100 mL. 

Results:  

K content in seeds/plant is _______ ppm.  

** % K = K ppm / 10000 

Video Link: 

https://www.youtube.com/watch?v=IxK_I-Q2e8w 

  



Estimation of Total Sulphur in Plants 

Principle: 

Since, dry ashing leads to volatilization loss of S present in the organic combination, and the wet 

oxidation based on tri- acid mixture includes H2SO4, both of these methods cannot be used for S 

determination in plant samples. Therefore, HNO3- HClO4 digest of plant is conveniently used. 

Turbidimetric method as described for soil sulphur or the barium chromate colorimetric method 

can be used for determination of S in the digest. Sulphur estimated by Turbidimetric method by 

using VIS-spectrophotometer at 490 nm (Chesnin and Yien 1950) and expressed the 

concentration in percentage. 

Apparatus:  

a) Spectrophotometer 

b) Volumetric flask 

c)  Pipette  

d) Conical flasks 

e) Beaker  

Reagents:  

1. Triacid mixture: see digestion of Seed and Plant samples.  

2. Sodium acetate acetic acid buffer (pH 4.8) [CH3COONa-CH3COOH]: 1000 mL 

volumetric flask add 100 g sodium acetate, add distilled water 500mL to mixed, add 30 

mL 99.5% acetic acid, shake to dissolved sodium acetate the makeup volume 1000mL 

mark.  

3. 0.25% Gum acacia solution: Dissolve 0.25g of chemically pure gum acacia powder in 

100 mL of hot water and filter in hot condition through Whatman No.42 filter paper. 

Cool and keep in refrigerator.  

4. Barium chloride crystal AR grade (BaCl2.2H2O): Pass AR grade BaCl2 salt through 1 mm 

sieve and store for use. 

5. 100 ppm S solution: Take 0.5434 g of K2SO4 and add 500mL distilled water to dissolved 

then make up to 1000 mL mark of volumetric flask. 



Procedure: 

a) After digestion (see digestion of Seed and Plant samples), Transfer 10 mL of digest filtrate 

in to 25 mL volumetric flask and gradually add 10 mL of sodium acetate acetic acid buffer.  

b) Add 1 g BaCl2.2H2O powder and shake well.  

c) Then add 1mL gum acacia and make up the volume with distilled water.  

d)  Run a blank without soil in similar manner.  

e) Measure the turbidity intensity at 490 nm  

f)  Run a blank side by side. 

Preparation of standard curve:  

Put 0, 1.25 2.5, 5.0, 7.5, 10.0, 12.5, 15.0 mL of the working standard solution (10 mg S/litre) into 

47 a series of 25 mL volumetric flasks to obtain 0, 0.5, 1.0, 2.0,3.0, 4.0, 5.0 and 6.0 ppm. 

Develop turbidity as described above for sample aliquots. Read the turbidity intensity and 

prepare the curve by plotting readings against sulphur concentrations. 

Precautions: 

1. The temperature of the digestion mixture during digestion should not exceed 2300C. 

2. The reading of the S in solution should be taken within 30 minutes from the development of 

turbidity. 

3. A clear and white residue in flask should remain after digestion. In case of incomplete 

digestion, the material should be again digested after addition of 5 mL of tri acid. 

Observation: 

Sl No. Spectrophotometer Reading (ppm) 

  

  

  

 

 



Calculation:  

S (mg/kg) in plant sample = R × d.f.  

Where,  

R = ppm reading of plant from standard curve 

Dilution Factor (d. f.) = Volume of extractant / Wt. of soil X Final Volume of solution/ Volume 

of digested extract 

                                          = 100 X 25/ 0.5 X 10 = 500 

Where,  

Weight of plant sample = 0.5 g, Volume of digested extract prepared = 100 mL, Volume of 

digested extract taken = 10 mL, Volume of final coloured extract prepared = 25 mL  

 

Results:  

S content in sees/plant _______ ppm.  

** % S = S ppm / 10000 

Video link: 

https://www.youtube.com/watch?v=nDW3vW6PnR0 

  

https://www.youtube.com/watch?v=nDW3vW6PnR0


Business idea: Development of irrigation water testing laboratory 

 

Collection of Water Samples 

  

 Irrigation is an important activity in crop production. Long term application of this water 

affects the soil property depending upon the quality of water used for irrigation. Concentration of 

soluble salt, alkalinity or excess of any particular element leads to the accumulation and related 

problem in crop production. Hence, quality should be determine and its suitability should be 

established before planning for long term use of any water resource. 

Water sampling is a vital part in analysis of the water for its quality appraisal for agricultural and 

environmental applications. Therefore, water sampling program starts with collections of 

samples which accurately represent the characteristics of the bulk material and handled 

conveniently in the laboratory while still providing test results. The major source of error in the 

whole process of obtaining water quality information often occurs during sampling. Over 50 % 

of the faulty data that occur in laboratory test results are due to sampling error, rather than during 

laboratory analysis. Adoption of the standard recommended practices helps in minimization of 

the sampling error. 

Selection of the sampling containers 

♦ Containers should be examined for cleanliness, ensuring it is strong and durable, so that it will 

not break in transit and that the cap does not leak once it is secured. 

♦ Containers must not contain any of the compounds that samples are to be analyzed for. 

♦ Container must be of the appropriate size. 

♦ Containers must be high density polyethylene or glass containers with Teflon® lid liners for 

most analyses. 

♦ Rubber and cork stoppers must not be used so as to avoid the risk of contaminating the sample. 

Water sampling techniques 

For collection of water sample following method may be adopted: 

♦ Glass or plastic bottles thoroughly cleaned and rinsed 3-4 times with the water to be tested 

should be used for collection of samples. The bottle should not be washed with detergents or 

soaps. 



♦ Take about 500 mL of sample after runing the tube well or hand pump for about 15-20 min. to 

drain out the water retained in the pipe. 

♦ If a new tube well boring is in progress, collect water samples at different depths at intervals of 

about 3-4 m. Since the water in such a situation is always turbid, with suspended impurities, it 

should be collected as such without caring for turbidity, as it does not affect the test results. 

♦ From a tank or pond collect the sample from at least 5 to 10 m away from the boundaries after 

displacing surface water, which might contain organic material floating over it. 

♦ From a well, the sample can be drawn either during irrigation, just before the water falls in the 

channel or by drawing it with the help of a bucket or any other clean container using a rope. The 

water surface should be disturbed a little to remove any floating material before collection of the 

sample. 

♦ Place the cap on the bottle tightly. 

♦ Write the name, address, sample no., identification mark etc. on the bottle. 

♦ Separately provide following information on the sheet of paper: 

• Name of the crop to be grown 

• Texture of soil to be irrigated, 

• Previous experience about the effect of the water on soil surface, 

• Previous test results if any, 

• Other sources available for irrigation, and 

• Crop performance so far. 

♦ Sample should be analysed preferably within 2-3 days of collection of the sample. 

♦ It is desirable to send both soil and water samples together for testing, as it helps in making the 

test reports and recommendations more fruitful. 

  



Estimation of irrigation water pH 

 pH of saline irrigation water, is not very much important since presence of neutral salts 

keeps it around 7.0. However the pH of bicarbonate waters is usually more than 7.5, its 

determination is very important because it may reflects the degree of sodicity in the water 

samples. 

 

 

Principle pH is the negative logarithm of hydrogen ions concentration. It is expressed as: 

pH = -log (H+) 

If pH below 7, the H+ ion concentration is exceeds to OH- and range is acidic. When the OH- 

concentration is more than H+, pH lies between 7 to 14 (alkaline range). 

The scale of measurement is from 1 to 14 on a pH scale: 

 

Equipment and Apparatus 

pH meter and 100 mL beakers 

Reagents 

♦ Buffer solutions (pH 4 and 9.2) 

pH 4.0: Prepare stock solution of 0.3 M potassium hydrogen phthalate by dissolving 15.3 g of 

 

 



the analytical grade salt in about 225 mL of hot water, cool the solution and dilut to 250 mL. 

Add a drop of toluene to discourage growth of micro-organisms. For the standard buffer pH 4.0 

mix 100 mL of the stock solution with 500 mL water. Prepare a fresh solution every week. 

pH 9.2 : Dissolve 3.81 g sodium tetraborate (AR) in water and dilute to 1000 mL. 

Procedure 

1. Calibrate the pH meter 

2. Take a 50 mL water sample in 100 mL flask, Put the combined electrode in the water sample and 

take the reading after 30 seconds. 

3. Remove the combined electrode from the sample and rinse thoroughly with distilled (DI) water 

in a separate beaker and carefully dry excess water with a tissue. 

Practical suggestions 

♦ Make sure that the combined electrode contains saturated KCl solution and some solid 

KCl. 

♦ Allow the pH meter to warm for 10 minutes before recording the pH. 

♦ Never allow the lower portion of glass electrode to touch the bottom of the beaker. 

  



Estimation of irrigation water Electrical Conductivity (EC) 

 Electrical Conductivity (EC) is the measure of the ability of a solution to carry an electric 

current or the concentration of soluble salts in the sample at any particular temperature. The EC 

measurement is affected by dissolved CO2, turbidity, temperature and the nature of various ions 

and their relative concentration. 

 

Equipment and apparatus 

Electrical conductivity meter, beakers 

Reagent 

♦ Potassium chloride (KCl) 0.01 M: Dissolve 0.7456 g of KCl in distilled water and make up the 

volume to 1 L at 25 0C. This is standard reference solution. At 25 0C it has an electrical 

conductivity of 1.412 dS m-1. 

Procedure 

1. Take about 75 mL water sample in a 100 mL beaker, and then put the clean and dried 

conductivity cell in beaker. 

2. Take the reading the display will also need some time to stabilize before the reading. 

3. Remove the conductivity cell from the glass beaker, rinse thoroughly with distilled water, and 

 



carefully dry excess water with tissue paper. 

Calculation 

The EC value can either be used as such for categorizing the water on salinity basis or may be 

used to get the concentration of as given below; 

Total soluble salt content (mg L-1) =EC (dS m-1) at 25 oC x 640 Total salt content me L-1 

(approximately) =EC (dS m-1) at 25 oC x 10 

Practical suggestions 

♦ Cleaning of the conductivity cell is needed if contaminated. 

♦ The reference temperature should be 25 °C, and the result expressed in dS m-1. If the 

measurement is carried out at a different temperature, the result should be corrected to 25 °C. 

Check accuracy of the EC meter using a 0.01 M KCl solution, which should give a reading of 

1.413 dSm-1 at 25 °C. 

♦ The use of the unit deci-Siemens per meter is preferred over the unit milli-mhos. Both units are 

equal, that is, 1 dSm-1 = 1 mmhocm-1.  



Estimation of Total Dissolved Solids (TDS) 

TDS is defined as the substances remaining after evaporation and drying of a water samples. The 

remaining fraction is approximately equivalent to the total content of the dissolved and 

suspended matter in the water sample. Non-filterable residue corresponds to the total suspended 

solids (TSS) and the filterable residue is the TDS. This is accomplished by comparing the value 

of calculated TDS with the measured value. Ion concentration, in mgL-1 of constituents, required 

to calculate the TDS are as follow: 

Calculated TDS (g L-1) = Na+K+Ca+Mg+Cl+S04+Si03+ (N03-N)+F 

Principle 

A well mixed, measured portion of a sample is filtered through a standard glass-fiber filter and 

the filtrate is evaporated to dryness in a weighed dish and dried to constant weight at 180 oC. The 

increase in dish weight represents the total dissolved solids. 

Apparatus 

♦ Evaporating dishes made porcelain 

♦ Platinum or high-silica glass 

♦ Steam bath 

♦ Desiccators provided with a desiccant containing a colour indicator for moisture 

concentration 

♦ Glass-fiber filters 

♦ Suction flask 

♦ Analytical balance 

Procedure 

1. Take an aliquot of sample to yield between 2.5 and 200 mg dried residue. 

2. Filter measured volume of well mixed water sample through the glass-fiber filter; 

3. Wash with 3 successive 10 mL volumes of distilled water, allowing complete draining between 

washing. 

4. Continue suction for about 3 minutes after filtration is complete. 

5. Transfer filtrate to a weighed evaporating dish (Wtd) and evaporate to dryness on a steam bath. 



6. Dry for at least 1 hour in an oven at 180 oC, cool in desiccators, and weigh (Wtd+s). 

7. Repeat the cycle of drying, desiccating and weighing until a constant weight is obtained or until 

weight loss between successive weighing is less than 4 % or 0.5 mg which is less. 

Calculation 
 

 

   

TDS (mg L_1)  =   (Wt d+S - Wtd) X 1000 

    V 

 
 
Where: 
 
Wtd+S= Weight of dish plus solids (mg) 

Wtd= Weight of dish before use (mg) 

V= Volume of water sample used for measurement (mL)  



Estimation of Total Suspended Solids 

Total Suspended Solids (TSS) applies to dry weight of the material that is removed from a 

measured volume of water sample by filtration with a standard filter. The test is basically 

empirical and is not subject to usual criteria of accuracy. To achieve reproducibility and 

comparability of results requires close attention to procedural details, especially filter 

characteristics and time and temperature of drying. 

Apparatus 

• Desiccators provided with a desiccant containing a colour indicator for moisture 
concentration 

• Analytical balance capable of weighing to 0.001 g 

• Glass-fiber filter disc, Whatman GF/C or equivalent 

• Drying oven 

• Buchner funnels 

• Vacuum pump 

 

 

Pre-treatment of filter disc and crucible 

1. Place a filter disc on the filter holder. Assemble filter holder in suction flask apparatus, connect 

to vacuum source and apply vacuum. 

2. Wash the filter disc with 3 successive 20 mL portions of distilled water. Continue to apply 

vacuum for 2-3 minutes after the water has passed through the filter. Discard the filtrate. 

3. Remove the filter paper from the membrane filter funnel or the Buchner funnel and place it on a 

supporting surface in drying oven. 

 



4. Place the crucible (s) in the drying oven. The oven should be maintained at 105 oC and drying 

should be continued for at least 1 hour. 

5. Cool the filter (s) and crucible (s) in desiccators and weigh it on an analytical balance. 

6. Repeat the cycle of drying, desiccating and weighing until the weight loss between two 

successive series operations is less than 

0. 5 mg. 

7. Store filter (s) and crucible (s) in desiccators until required. 

Procedure 

1. Remove the filter disc and crucible from the desiccators, and weigh (Wtf+c). 

2. Place the filter in the filter holder and assemble the filter holder in the suction flask apparatus. 

Connect to the vacuum source and apply vacuum. 

3. Wet the filter with a few drops of distilled water to seat the filter. 

4. Shake the sample vigorously and measure out 100 mL in a 100 mL graduated cylinder or volume 

flask. Pour this portion of the sample into the filter funnel (be careful not to disturb the placing of 

the filter disc). 

5. Rinse out the measuring flask or cylinder with a small quantity of distilled water. If the sample is 

very low in suspended material, a large volume of sample may be used. 

6. When filtration is complete, carefully remove the filter disc from the filter holder with tweezers 

(or remove the crucible from its supporting socket with a pair of tongs), and place it in the drying 

oven. 

7. Dry for at least 1 hour at 105 oC. Cool in desiccators, and weigh (Wt+c+s). 

8. Repeat the drying, desiccating and weighing cycle until the weight loss between 2 successive 

weighing is less than 0.5 mg. 

9. Record the final weight obtained 

Calculation 

TSS (mg L x) = (Mtfc+s – Wtf+C ) x 1000 

                                            V 

 



Where: 

Wtf +c+s= Weight of filter and crucible plus solids (mg)  

Wtf+c= Weight of filter and crucible before use (mg) 

V = Volume of water sample used for measurement (mL) 

  



Estimation of Biological Oxygen Demand 

  

 Microorganisms such as bacteria are responsible for decomposing organic waste. When 

organic matter is discharged into a watercourse it serves as a food source for the bacteria present 

there. If organic matter such as dead plants, leaves, grass clippings, manure, sewage, or even 

food waste is present in a water supply, the bacteria will begin the process of breaking down this 

waste. Biological Oxygen Demand (BOD) is a measure of the oxygen used by microorganisms 

to decompose this waste. BOD refers to the amount of oxygen that would be consumed if all the 

organics in one litre of water were oxidized by bacteria and protozoa. If there is a large quantity 

of organic waste in the water supply, there will also be a lot of bacteria present working to 

decompose this waste. 

Principle 

This test is based on Winkler’s Method. Oxygen combines with Mangnous hydroxide to form 

higher hydroxides, which on acidification liberate iodine equivalent to that of oxygen fixed. This 

iodine is titrated by standard Sodium thiosulfate solution using starch as an indicator. 

Test Procedure 

The BOD test takes 5 days to completeand is performed using a dissolved oxygen (DO) test 

procedure. The BOD level is determined by comparing the DO level of a water sample taken 

immediately with the DO level of a water sample that has been incubated in a dark location for 5 

days. The difference between the two DO levels represents the amount of oxygen required for 

the decomposition of any organic material in the sample and is a good approximation of the 

BOD level. 

Reagents: 

♦ 0.0250 M Sodium thiosulfate: 3.1 g sodium thiosulfate pentahydrate (Na2S2O3 ^5H2O) in 

reagent water. Add 0.2 g sodium hydroxide (NaOH, 1 to 2 pellets) and dilute to 500 mL. 

Alternate: Dissolve exactly 6.206 grams sodium thiosulfate crystals in freshly boiled and cooled 

reagent water and make up water to a volume of 1 liter. For preservation, add 0.4 gm or 1 pellet 

of sodium hydroxide. Solutions of “thio” should be used within two weeks to avoid loss of 

accuracy because of decomposition of the solution. Alternate: Phenylarsine Oxide solution 



(PAO) may be used instead of “thio” [0.025 N PAO available and standardized from commercial 

sources.] 

♦ Alkaline Iodine Azide (AIA) solution: 50 g sodium hydroxide (NaOH) and 15 g potassium 

iodide (KI) are dissolved in reagent water and diluted to 100 mL. Add 1 g sodium azide (NaN3) 

dissolved in 4 mL distilled water. 

♦ starch solution: 2 g starch and 0.2 g salicylic acid dissolved in 100 mL hot water. 

♦ Manganous Sulfate solution: Dissolve 40 g Manganoussulfatedihydrate (MnSO4 • 2H2O) in 

reagent water, filter and dilute to 100 mL. 

♦ Sulfuric acid: Use concentrated reagent grade acid (H2SO4). Handle carefully, since this 

material will burn skin and clothes. 

♦ Potassium Iodide (KI) crystals 

Standardization (Procedure): 

1. Dissolve 2 g potassium iodide in approximately 100 mL Erlenmeyer flask. 

2. Add 1.0 mL concentrated Sulfuric acid. 

3. Add a magnetic stir bar. 

4. Fill burette with the sodium thiosulfate solution and lower level to 0.0 marks. Be sure that the tip 

of the buret is filled with solution and not air. 

5. Begin stirring and add sodium thiosulfate solution to the flask until a light yellow 

colordeveloped. 

6. Add about 2 mL of starch solution. The color will change to deep blue or purple. 

7. Continue addition of sodium thiosulfate until the solution clears permanently. Stop the titration 

and record the volume of of sodium thiosulfate used. 

8. If exactly 20 mL of sodium thiosulfate solution is used it can be recorded as standardized at 

0.0250 M. If less than 20 mL are needed, add some reagent water to the sodium thiosulfate 

solution (5 mL reagent water to 100 mL titrant for each 1 mL that the titrant is low). If more than 

20 mL are required, add solid sodium thiosulfate to the titrant solution (310 mg per 1000 mL for 

every 1.00 mL the titrant is high). Recheck the standardization. 



9. Repeat the standardization and record both determinations and the average in the notebook. 

Procedure 

1. Collect samples in 300 mL BOD bottle taking special care to 

avoid aeration of the liquid being collected. Fill bottle 

completely (no air under cap). Samples should be taken in 

triplicate. Keep one bottle of each set in an incubator at 20°C 

for 5 days. 

2. Insert stopper in bottle prepared for DO, then remove. 

3. Add, under the surface of the sample, 1-2 mL Manganous Sulfate solution. 

4. Immediately add 1-2 mL Alkaline Iodide Azide solution below the surface of the liquid. 

5. Insert stopper in bottle, avoid trapping air bubbles, and invert it until it mix well. Repeat this 

shaking after the flock has settled halfway. 

6. Allow flock to settle to half the volume of the bottle a second time, then open and add 1-2 mL 

concentrated Sulfuric acid by allowing the acid to run down the neck of the bottle above the 

surface of the liquid. 

7. Insert stopper and invert to mix until the flock dissolves. 

8. Transfer the solution to an Erlenmeyer flask with magnetic stir bar for the titration procedure. 

9. Titrate with the 0.0250 M sodium thiosulfate solution until the solution is pale yellow. 

10.Add 2 mL starch and continue titration until the color is permanently discharged. Record the 

volume of sodium thiosulfate used.Each 1.00 mL of 0.025 M sodium thiosulfate used is 

equivalent to 1.00 mg L-1 DO. 

11.Repeat same steps with other samples earlier kept in incubator and record DO. 

Calculation: 

Vol. of Na7S707 sol.Used xW of Na7S7O3 x8000 

  Vol. of taken 

 

BOD (mg L-1) = DOj — DOf 

  P 

Where, 

DO mg equivalent = 



DOi. and DOf are initial and final values of DO. 

P is the decimal fraction of sample diluted in the 300 mL BOD bottle. 

Ranges for typical BOD levels in water bodies are 

♦ < 5 mg L-1 in natural, unpolluted waterways 

♦ 20-30 mg L-1for well-treated sewage 

♦ 150-300 mg L-1for raw sewage 

♦ 100-500 mg L-1for urban storm water runoff. 

Precautions 

♦ Test should be done as early as possible after sample collection. 

♦ If test is not started within two hours of collection, it should be kept at 4 °C up to 6 hours. 

♦ Do not open BOD bottles before analysis. 

♦ The pH of samples should be adjusted between 6.5 - 7.5 using sulfuric acid or sodium 

hydroxide. 

  



Estimation of different forms of Nitrogen in water 

 Nitrogen generally occurs in trace amount in surface (river, canal) water but can be 

present in higher concentration in some ground waters (tubewells). Beneficial effect of nitrogen 

on crop production has been widely reported. The presence of K+ and NO3
- ions in appreciable 

amounts in irrigation water has been found to partially counteract the adverse effect of salinity 

and sodicity on plant growth. In drinking waters, nitrates content higher than 10 mg L-1 it causes 

illness called methaeglobinaemia or blue baby syndrome in infants. Water may contain nitrogen 

in different forms such as nitrate, nitrite, ammonia and organic nitrogen. Total nitrogen includes 

all forms of nitrogen. The concentration of nitrogen in water samples can be used to assess 

nutrient status of the water resources or as indicator water pollution due to enrichment from 

various sources such as fertilization of crop lands, animal wastes, sewage and growth of nitrogen 

fixing plants. Depending upon the objective, the water samples can be analysed for total as well 

as water soluble inorganic nitrogen. 

A. Water soluble inorganic nitrogen 

Principle 

Ammonium nitrogen and NO3
- N plus NO2

- N are determined by steam distillation, using heavy 

MgO for NH4 and Devarda’s Alloy for NO3 .The distillate is collected in saturated H3BO3 and 

titrated to pH 5.0 with dilute H2SO4. 

Apparatus 

♦ Distillation unit 

♦ Automatic titrator connected to a pH-meter 

♦ Stirrer 



 

Reagents 

♦ Magnesium Oxide (MgO), powder: Heat heavy magnesium oxidein a muffle furnace at 600-700 

°C for 2 hours, and cool in a desiccators containing KOH pellets, and store in a tightly stoppered 

bottle. 

♦ Devarda’s Alloy (50 Cu: 45 Al: 5 Zn):Ball-mill reagent-grade Devarda’s Alloyuntil the product 

will pass a 100-mesh sieve (0.150 mm) and at least 75% will pass a 300-mesh sieve (0.05 mm). 

♦ Boric Acid Solution (H3BO3), saturated: Add 500 g H3BO3into a 5-L volume. Add 3 L distilled 

water (DI), and swirl vigorously and leave overnight. 

♦ Tris Solution (hydroxymethylaminomethane) (C4HuNO3), 0.01 N: Dry reagent-grade Trisin an 

oven at 80 °C for 3 hours, cool in a desiccator, and store in a tightly stoppered bottle. 

♦ Sulfuric Acid Solution (H2SO4), 0.01 N : Add 28 mL concentrated H2SO4, to about 600-800 mL 

distilled water in a 1L flask, mix well, let it cool, and bring to 1 L volume. This solution contains 

1 N H2SO4 solution (Stock Solution). Pipette 10 mL Stock Solutionto 1 L flask, and bring to 

volume with distilled water. This solution contains 0.01 N H2SO4. 

♦ Standard Stock Solution 

• Dry reagent-grade ammonium sulfate (NH4)2SO4, and potassium nitrate (KNO3) in an oven at 100 

°C for 2 h, cool in a desiccators, and store in a tightly stoppered bottle. 

• Dissolve 5.6605 g (NH4)2 SO4 and 8.6624 g KNO3 in distilled water, and bring to 1 L volume. 

This solution contains (1.2 g NH4-N, and 1.2 g NO3
-N) L-1 (Stock Solution). 

• Prepare a Standard Solution from the Stock Solution as follows: Dilute 50 mL Stock Solution to 

1 L volume by adding 2 MKCl solution (Diluted Stock Solution). 

 



• A 20 mL aliquot of Diluted Stock Solution contains 1.2 mg NH4 N and 1.2 mg NO3 N. 

Procedure 

Pre-treatment of the distillation unit 

1. The distillation unit should be steamed out for at least 10 minutes. Adjust steam rate to 7-8 mL 

distillate/minute. 

2. Water should flow through the condenser jacket at a rate sufficient to keep distillate temperature 

below 22 °C. 

Distillation 

1. Before starting a batch for distillation, the distillation unit should be steamed out for at least 10 

minutes. Adjust steam rate to 7 - 8 mL distillate per minute. Water should flow through the 

condenser jacket at a rate sufficient to keep distillate temperature below 22 °C. 

Calibrate pH meter with buffer solutions of pH 7.0 (buffer), and 4.0 (sensitivity), after 

setting for temperature. Then standardize the 0.01 N H2SO4 in the Auto-Titrator by 

titrating three separate 10 mL aliquots of the primary standard, 0.01 N Tris solution, to pH 5.0. 

The titrations should agree within 0.03 mL; if not; titrate further aliquots until agreement is 

found. The H2SO4 normality is: 

10 X NTris 

VH2SO4 

Carry out distillations as follows 

To determine NH4-N 

1. Pipette 20 mL water or wastewater sample into a 100 mL distillation flask. 

2. Pipette 1 mL saturated H3BO3 solution and 1 mL distilled water into a 50 mL beaker (duplicate 

beakers). 

3. Place the first beaker underneath the condenser tip, with the tip touching the solution surface. 

4. Add about 0.2 g heavy MgO, with a calibrated spoon, to the distillation flask. 

5. Immediately, attach the distillation flask to the distillation unit with a clamp. 

6. Start distillation, and continue for 3 minutes, then lower the dish to allow distillate to drain freely 

2. 

N H2S04 = 



into the Pyrex evaporating dish or beaker. 

7. After 4 minutes, when 35 mL distillate or more is collected, turn off the steam supply and 

remove the distillation flask (first distillate). 

8. Each distillation should contain at least two standards (pipette 20 mL 1.2 mg NH4 N from 

Diluted Stock Solution) and two blanks (pipette 20 mL 2 KCl solution). Recovery of NH4 N 

should be at least 96 %. 

To determine N03
-N and N02

-N 

1. Place the second beaker underneath the condenser tip, with the tip touching the solution surface. 

2. Immediately, add 0.2 g Devarda’s alloy, with a calibrated spoon, to the same distillation flask, 

then attach back to distillation unit with a clamp, and start distilling. 

3. After 4 minutes, when 35 mL distillate or more is collected, turn off the steam supply and 

remove the distillation flask (second distillate). 

4. Wash tip of the condenser into Pyrex evaporating dish or the beaker with a small amount of 

distilled water. 

5. Each distillation should contain at least two standards (pipette 20 mL 1.2 mg NO3
- N from 

Diluted Stock Solution) and two blanks (pipette 20 mL distilled water). Recovery of NO3-N 

should be at least 96 %. 

Titration 

Titrate the first distillate (for ammonia) and the second distillate (for nitrate), separately, to pH 

5with standardized 0.01 N H2SO4using an Auto-Titrator. 

Calculation 

Where: 

V= Volume of 0.01 N H2SO4 titrated for the water sample (mL) 

B = Distillate blank titration volume (mL) 

N = Normality of H2SO4 solution 

VI= Volume of water sample used for distillation (mL) 

14.1= Atomic weight of N 



Technical remarks 

♦ If possible, NH4+ N and NO3
- N should be determined immediately after sampling. If the 

analysis cannot be done immediately, water and wastewater samples may be kept refrigerated (4 

°C). 

♦ All water for reagents and dilution should be NH3free. Distilled water is usually satisfactorily. 

♦ Filter paper may contain traces of NH4+, so the first 20-25 mL of filtrate should be discarded. 

♦ Never use acid preservation for samples to be analyzed for NO3
- or NH4+.  



Total Nitrogen 

For the total nitrogen water samples can be analyzed after digesting the samples by persulphate 

digestion followed by colourimetric estimation of nitrate nitrogen. Alternatively water samples 

can also be analysed for total Kejldahl nitrogen. 

Persulphate oxidizable total nitrogen 

Alternately In this method salicylic acid is nitrated in an alkaline solution and light absorbance is 

measured at 410 nm 

Apparatus and equipments: 

Spectrophotometer, test tube shaker, autoclave, glass culture tube with Teflon lined screw cap. 

Reagents 

♦ Oxidizing agent: oxidizing agent is prepared by adding 25 g potassium persulphate AR grade 

(K2S2O8) and 15 g of boric acid AR grade (H3BO4) in 50 mL of 3.75 M NaOH solution and the 

volume is made up to 500 mL with double distilled water. The reagent can be stored for upto 1 

week at room temperature in dark bottle. 

♦ 3.75 M NaOH:Dissolve 75 g NaOH in 500 mL distilled water 

♦ 4 M NaOH solution: Dissolve 160 g NaOH cakes in 600 mL distilled water, make up to 1000 

mL and mix well 

♦ 5% Salicylic Acid: Dissolve 5 g salicyclic acid in 95 mL concentrated H2SO4 (95-97%). 

♦ 1000 mg NO3
- L-1 solution: Dissolve 7.223 g dry potassium nitrate in distilled water and make up 

to volume in a 1000 mL volumetric flask 

♦ Working standards: Pipette 0, 0.2, 0.4, 0.6, 0.8, and 1.0 mL of stock solution in 100 mL 

volumetric flaks and make up to volume to give the 0, 2, 4, 6, 8 and 10 mg NO3
- L-1 working 

standards. 

Procedure 

1. Take 5 mL water sample in glass culture tube to this add 5 mL of the oxidizing agent, and 

immediately sealed the culture tube with screw caps containing Teflon liners. 

2. Set a blank with 5 mL distilled water in place of aliquot 



3. Autoclave the culture tube at 120 °C for 50 min. 

4. After autoclaving cool the culture tube 

5. Pipette 0.5 aliquot and each of the working standards in test tube for NO3
- N determination 

6. Add 1 mL of 5% salicylic acid slowely with stirring and wait for 30 min 

7. Now add 10 mL of 4 M NaOH solution slowely and leave for 1 h for colour development 

8. Mix the reagents properly using cyclomixer 

9. Read the absorbance of the yellow colur at 410 nm using spectrophotomer 

10. Plot the standard curve from absorbance versus concentration and find out the sample and blank 

concentration 

Calculation: 

NO3
- N (mg L-1) = (S-B) x 2 

Where S= concentration of NO3
- N (mg L-1) in sample B = concentration of NO3

- N (mg L-1) in 

blank Factor “2” is the dilution factor during digestion of the sample 

  



Total Kejldahl nitrogen 

The Kjeldahl procedureis a good estimate of N content in the water or waste water samples. This 

procedure involves digestion and distillation. The water or waste water sample is digested in 

concentrated H2SO4 with a catalyst mixture to raise the boiling temperature and to promote the 

conversion from organic-N to ammonium-N, which is obtained by steam distillation, using 

excess NaOH to raise the pH. The distillate is collected in saturated H3BO3; and then titrated 

with dilute H2SO4 to pH 5.0. 

 

Apparatus 

• Block-digester 

• Distillation unit 

• Automatic titrator connected to a pH-meter 

• Vortex tube stirrer 

Reagents 

♦ Catalyst Mixture (K2S04 - Se), 100: 1 w/ w ratio: Grind reagent-grade chemicals separately and 

mix. If caked, grind the mixture in a porcelain pestle and mortar to pass a 60-mesh screen (0.250 

mm), taking care not to breath Se dust or allow Se to come in contact with skin. 

♦ Sulfuric Acid (H2SO4), concentrated (98 %, sp. gr. 1.84) 

♦ Sodium Hydroxide Solution (NaOH), 10 N:Dissolve 400 g NaOH in distilled water, transfer to a 

1 L heavy-walled Pyrex flask, let it cool, and bring to volume. 

♦ Boric Acid Solution (H3BO3), saturated:Add 500 g H3BO^into a 5 L volume. Add 3 L DI water, 

and swirl vigorously. Leave overnight. 

♦ Tris Solution [hydroxymethylaminomethane] (C4H11NO3), 0.01 N:Dry reagent-grade Tris in an 

oven at 80 °C for 3 hours, cool in a desiccator, and store in a tightly stoppered bottle. Dissolve 

1.2114 g Trisin distilled water, and bring to 1 L volume 

♦ Sulfuric Acid Solution (H2SO4), 0.01 N:Add 28 mL concentrated H2SO4 to about 600 - 800 mL 

distilled water in a 1 L flask, mix well, let it cool, and bring to 1-L volume. This solution 

contains 1 N H2SO4 solution (Stock Solution). Pipette 10 mL Stock Solutionto 1-L flask, and 



bring to volume with DI water. This solution contains 0.01 N H2SO4. 

♦ Standard Stock Solution:Dry reagent-grade ammonium sulfate (NH4)2SO4in an oven at 100 °C 

for 2 hours, cool in a desiccator, and store in a tightly stoppered bottle. Dissolve 5.6605 g dried 

(NH4)2SO4in distilled water, and bring to 1 L volume. This solution contains 1.2 g NH4 N L-1 

(Stock Solution). 

Procedure A. Digestion 

1. Pipette 20 mL aliquot of the water sample into a 100 mL calibrated digestion tube. 

2. Add about 3.0 - 3.5 g catalyst mixture, a few pumice boiling granules, add 10 mL concentrated 

H2SO4 (in the fume hood) and then swirl carefully. Place the tubes in the rack and put a glass 

funnel in the neck of the tube. 

3. Place the tubes rack in the block-digester, and slowly increase temperature setting to about 370 - 

380 °C. The H2SO4 should condense about half-way up the tube neck; when solution clears, 

continue heating for about 3 hours. 

4. Lift the tubes rack out of the block-digester, carefully place on a rack holder, and let tubes cool 

to room temperature. 

5. Slowly add about 15 mL distilled water to the tubes, cool, and bring to volume with distilled 

water. 

6. Each batch of samples for digestion should contain at least one reagent blank (distilled water 

sample), and one chemical standard (distilled water sample, pipette 1 mL Stock Solution). 

Distillation 

1. Before starting a batch for distillation, the distillation unit should be steamed out for at least 10 

minutes. Adjust steam rate to 7-8 mL distillate per minute. Water should flow through the 

condenser jacket at a rate sufficient to keep distillate temperature below 22 °C. 

2. Calibrate pH meter with buffer solutions of pH 7.0 (buffer), and 4.0 (sensitivity), after setting for 

temperature. Then standardize the 0.01 N H2SO4 in the Auto-Titrator by titrating three separate 

10 mL aliquots of the primary standard, 0.01 N Tris solution, to pH 5.0. The titrations should 

agree within 0.03 mL; if not; titrate further aliquots until agreement is found. 



The H2SO4 normality is: 

Carry out distillations as follows: 

1. Dispense 1 mL saturated H3BO3 solution and 1 mL distilled water into a 100 mL Pyrex 

evaporating dish, placed underneath the condenser tip, with the tip touching the solution surface.

2. Pipette 20 mL aliquot into a 100 mL distillation flask, and add 10 mL 10N NaOH solution. 

3. Immediately attach the flask to the distillation unit with a clamp, start distillation, and continue 

for 3 minutes, lower the dish to allow distillate to drain freely into the dish. 

4. After 4 minutes when about 35 mL distillate is collected, turn off the steam supply, and wash tip 

of the condenser into the evaporating dish with a small amount of DI water. 

5. Titrate the distillate to pH 5.0 with standardized 0.01 N H2SO4 using an Auto-Titrator. 

6. Each distillation should contain at least two standards (pipette 10 mL digested water sample) and 

two blanks (pipette 10 mL digested water blank). Recovery of NH4-N should be at least 96 %. 

Notes 

♦ After finishing titration, wash the Teflon-coated magnetic stirring bar, the burette tip, and the 

combined electrode into the dish. 

♦ Between different samples, steam out the distillations. Disconnect distillation flasks containing 

the digest sample and NaOH, and attach a 100 mL empty distillation flask to distillation unit. 

Place a 100 mL empty beaker underneath the condenser tip, turn off cooling water supply (drain 

the water from the condenser jacket), and steam out for 90 seconds.   

 

Calculation: 

 

 

 

 

 

 

Where: 

% Recovery = ( V - B )  x / V x  14.01 x 100 

V3 x C 



 

V = Volume of 0.01 N H2SO4 titrated for sample (mL) V1= Total volume of the digest (mL) 

V2= Volume of water digest used for distillation (mL) 

B = Digested blank titration volume (mL) 

N = Normality of H2SO4 solution 

14.1 = Atomic weight of N 

V3 = Volume of NH4-N standard solution (mL) 

C = Concentration of NH4-N standard solution (pg mL-1)  



 

Estimation of different forms of Phosphorus in water 

Phosphorus compounds are present in fertilizers and in many detergents. High concentration of P 

compounds may produce a secondary problem in water bodies. In such situations, the presence 

of additional P compounds can stimulate algal growth and enhances eutrophication.Groundwater 

rarely contains more than 0.1 mgL-1 phosphate if not polluted by organic matter. Phosphorus is 

essential to the growth of organisms and can be the nutrient that limits biological growth in water 

bodies. The water samples are analysed for the total as well as soluble reactive phosphorus 

A. Soluble reactive phosphorus (SRP) 

Soluble reactive phosphorus (SRP) describes the dissolved phosphates that respond to 

colorimetric tests without preliminary hydrolysis or oxidative digestion of the sample and are 

termed ‘reactive phosphorus’. Reactive phosphorus is largely a measure of orthophosphate 

(PO4
3-); however, a small fraction of any condensed phosphate present is usually hydrolysed 

unavoidably in the analytical procedure. Reactive phosphorus occurs as both dissolved and 

suspended phosphorus. 

Principle 

SRP can be determined by vanadomolybdo phosphoric acid(colorimetric methods), where are the 

ammonium molybdate and potassium antimony tartrate react in acid medium with 

orthophosphate to form a heteropoly acid-phosphomolybdic acid- that is reduced to an intensely 

colored molybdenum blue by ascorbic acid. 

Apparatus 

• Spectrophotometer or colorimeter 

• Standard laboratory glassware: beakers, volumetric flasks, pipettes, funnels 



 

 

Reagents 

♦ Sulfuric Acid Solution (H2SO4), 5 MDilute 148 mL concentrated H2SO4 (in fume hood) with DI 

water, mix well, let it cool, and bring to 1-L volume. 

♦ p-nitrophenol Indicator, 0.25 % w/v 

♦ Reagent A:Dissolve 12 g ammonium heptamolybdate(NH4)6Mo7O24.4H2O in 250 mL distilled 

water (a).Dissolve 0.2908 g antimony potassium tartrate(KSbO.C4H4O6) in 100 mL distilled 

water (b).Add both dissolved Reagents (a) and (b) to a 2 L flask. Slowly add 1-L 5 N H2SO4to 

the mixture. Mix thoroughly, and dilute to 2-L volume.Store in a dark Pyrex bottle in cool place. 

♦ Reagent B:Dissolve 1.056 g L-Ascorbic acid (C6H8O6) in 200 mL Reagent A, mix well. This 

reagent should be prepared as required because it does not keep for more than 24 hours. 

♦ Standard Stock Solution:Dry about 2.5 g potassium dihydrogen phosphate(KH2PO4) in an oven 

at 105 °C for 1 hour. Cool in desiccator, and store in a tightly stoppered bottle. Dissolve 2.197 g 

dried KH2PO4in distilled water, and bring to 1 L volume .This solution contains 500 ppm P 

(Stock Solution). Dilute 50 mL stock solutionto 250 mL volume by adding distilled water. This 

solution contains 100 ppm P (Diluted Stock Solution). Prepare a series of working standard 

solutions from the diluted stock solutionas follows: 

Dilute 5, 10, 15, 20 and 25 mL Diluted Stock Solutionto 500 mL numbered flasks by adding 

distilled water, and then bring to volume. These solutions contain 1, 2, 3, 4, and 5 ppm P, 

respectively. 

 



 

Procedure 

1. Pipette a suitable aliquot of clear filter water sample (10 mL natural water sample) into a 50 mL 

Erlenmeyer volumetric flask add few drops of p-nitrophenol indicator 

2. Add the required acid or base to all the water samples to bring the solution pH to 5.0. 

3. Add 8 mL Reagent B, and dilute to 50 mL volume with distilled water, mix well. 

4. Prepare a standard curve by pipetting 2 mL of each standard (1-5 ppm), and proceed as for the 

samples. Also make a blank with only distilled water, and proceed as for the samples. 

5. Read the absorbance of blank, standards, and samples after 10 minutes on the Spectrophotometer 

at 882 nm wavelength. 

6. Prepare a calibration curve for standards, plotting absorbance against the respective P 

concentrations. 

7. Read P concentration in the unknown samples from the calibration curve. 

Calculation 

P (mg L-1) = P mg L-1 from standard curve x 
𝑽𝟏

𝑽
 

Where: 

V= Volume of water sample used for measurement (mL) 

VI= Volume of flask used for measurement (mL) 

B. Total Phosphorus 

Phosphorus occurs in natural waters and in wastewaters almost solely as phosphates. In water it 

may be in several forms like orthophosphates (PO4
3-), condensed phosphates (pyro-, meta-, and 

other polyphosphates), and organically bound phosphates. They occur in solution, in particle or 

detritus, or in the bodies of aquatic organisms. Phosphorus enrichment in water bodies may be 

from detergents in sewage and waste waters, fertilizers, animal wastes, sewage and some 

industrial wastes. High levels of phosphorus and/or other key nutrients may lead to 

eutrophication of the water bodies. Total phosphorus in water samples can be analyzed after 

digesting the samples by persulphate digestion followed by colourimetric estimation of 

phosphorus as given in section. 



 

Reagents 

1. Oxidizing agent: oxidizing agent is prepared by adding 10 g potassium persulphate AR grade 

(K2S2O8) and 1.5 g of NaOH in 500 mL volumetric flask and the volume is made up to 500 mL 

with double distilled water. The reagent can be stored for upto 1 week at room temperature in 

dark bottle. 

2. Reagents of the P estimation as given SRP estimation 

Procedure 

1. Take 5 mL water sample in glass culture tube to this add 5 mL of the oxidizing agent, and 

immediately sealed the culture tube with screw caps containing Teflon liners. 

2. Autoclave the culture tube at 120°C for 30 min. 

3. After autoclaving cool the culture tube and 

4. Take suitable volume of aliquot and develop the colour as mentioned in soluble reactive 

phosphorus estimation section 

5. Read the absorbance using spectrophotometer. 

Calculation: 

P mg L-1 = 2 x P mg L-1 from standard curve x v1/v 
 
 
 

  



 

Estimation of Potassium in irrigation water 

Although potassium (K) is a relatively abundant element, its concentration in natural fresh waters 

is usually less than 20 mgL-1. Brines and seawater, however, may contain as much as 400 mgL-1 

K or more. Potassium in water can be determined by flame photometry. 

Principle 

The estimation of K is based on the emission spectroscopy, which deals with excitation of 

electrons from ground state to a higher energy state and coming back to its original state with the 

emission of light. 

Apparatus 

• Flame photometer with accessories 

• Beakers 

• Pipettes and volumetric flasks, as required for dilution and tests of interference 

effects 

 

Reagents 

Standard Stock Solution 

♦ Dry 3-5 g potassium chloride (KCl) in an oven at 120 °C for 1 -2 hours and cool in a desiccator, 

and store in a tightly stoppered bottle. 

♦ Dissolve 1.907 g dried KClin distilled water, and bring to 1-L volume. This solution contains 

1000 ppm K (Stock Solution). 

 



 

♦ Prepare a series of Standard Solutions from the Stock Solution as follows: Dilute 2, 4, 6, 8, 10, 

15 and 20 mL Stock Solution to 100 mL numbered flasks by adding distilled water, and then 

bring to volume. These solutions contain 20, 40, 60, 80, 100, 150, and 200 ppm K, respectively. 

Procedure 

1. Filter a portion of water sample through Whatman no. 42 filter paper. 

2. Calibrate Flame Photometer with a series of suitable K standards with distilled water as 

blank sample. 

3. Measure the water samples, take the emission reading on the Flame Photometer at 767-

nm wavelength, and record the readings. 

4. Draw a calibration curve. 

5. Calculate K concentrations according to the calibration curve. 

Calculations 

K (meL-1 ) = K(ppm) from standard curve/39.1 

Where: 

39.1= Atomic weight of K 

Practical suggestions 

♦ Check the performance of the photometer at frequent intervals by spraying some of the standard 

solutions and adjust the sensitivity as necessary. 

♦ If K concentration is higher than the top standard, make an appropriate dilution. If this is a 

dilution of the original sample, multiply by the appropriate factor. 

  



 

Estimation of Chlorides in irrigation water 

Important anions from water quality point of view are chloride, carbonate and biocarbonate, 

sulphates and nitrate. Concentration of chloride generally increases with increasing in electrical 

conductivity (EC) of waters. Therefore, magnitude of total salt may be predicted if chloride 

concentration is known. 

Chloride (Cl-) anions are usually present in natural waters. A high Cl- concentration occurs in 

waters that have been in contact with Cl-containing geological formations. Otherwise, high Cl-

content may indicate pollution by sewage or industrial wastes or by intrusion of seawater or 

saline water into a freshwater body or aquifer. A salty taste in water dependents on the ions with 

which the Cl-are associated. With Na ions the taste is detectable at about 250 mgL-1, but with Ca 

or Mg the taste may be undetectable at 1,000 mg L-1. Chlorides being highly soluble is present in 

all waters but the amount is often very low in natural waters. 

Principle 

The determination of Cl- is done by AgNO3 (Mohrs’s titration) method, which is based upon the 

fact that in solution containing Cl- and chromate. Silver reacts with all the Cl- and precipitates 

before the reaction with chromate begins. The appearance of the brick-red colour of the silver 

chromate precipitate is the end-point of the titration. 

Apparatus 

Burette and stand, volumetric flask and Beakers 

Reagents 

♦ Potassium Chromate Solution (K2Cr04), 5% in water: Dissolve 5 g K2CrO4 in 50 mL distilled 

water. Add dropwise 1 N silver nitrate (AgNO3) until a slight permanent red precipitate is 

formed. Filter, and bring to 100 mL volume with distilled water. 

♦ Silver Nitrate Solution (AgNO3), 0.01 N; Dry about 3 g AgNO3 in an oven at 105 °C for 2 hours, 

cool in a desiccators, and store in a tightly stoppered and brown bottle. Dissolve 1.696 g dried 

AgNO3in distilled water, and bring to 1 L volume. 

♦ Sodium Chloride Solution (NaCl), 0.01 N:Dry about 3 g NaCl in an oven at 140 °C for 2 hours, 

cool in a desiccator, and store in a tightly stoppered and brown bottle. Dissolve 0.585 g NaCl in 



 

distilled water, and bring to 1 L volume. 

Procedure 

1. Pipette a suitable aliquot of water sample (10 mL natural water sample) into a 250 mL 

Erlenmeyer flask. 

2. Add 4 drops potassium chromate solution. 

3. Titrate against AgNO3 solution until a permanent reddish-brown color appears. 

4. In order to standardize the AgNO3 solution used in the determination of Cl-: 

• Titrate 10 mL 0.01N NaCl solution against 0.01 N AgNO3 after adding 4 drops potassium 

chromate solution until a permanent reddish-brown color appears. 

• Take the reading, and calculate AgNO3 normality: 

 

 

 

 

Where: 

NAgNO3= Normality of AgNO3 solution  

VAgNO3= Volume of AgNO3 solution used (mL) NNaCl= Normality of NaCl solution 

 

 

 

 

 

Where: 

V1 = Volume of 0.01 N AgNO3 titrated for the sample (mL) 

N = Normality of AgNO3 solution V = Volume of water sample used for measurement (mL) 

Practical suggestions 

1. Natural waters are often low in Cl-, and 10 mL is a suitable aliquot in most cases. 

2. Saline waters may be high in Cl-and 5 mL (or even less than 5 mL) may then be more 

appropriate aliquots.  

N AgN03= 10 x N NaCl 

VAgN03 

Cl (me L ) = 
V1 x N x 1000 

V 



 

Estimation of Carbonate and Bicarbonate in irrigation water 

Carbonate and bicarbonate in a sample can be determined by titrating the sample against 

standard acid using phenolphthalein and methyl orange or methyl red respectively as indicators. 

When the colour of phenolphthalein changes from pink to colorless, it indicates half the 

neutralization of carbonates. Now methyl red indicator is added and the titration continued. 

When the colour changes from yellow to rose red, end point reaches which show the complete 

neutralization of bicarbonates. 

Principle 

Carbonates 

When the pH value of a sample of natural water is above 8.4, the CO3
-- is present, normally as 

sodium carbonate. The carbonate ion is converted to HCO3. The amount of acid used a measure 

of the carbonate present. 

C03
2- + H+ = HCO3

-; 

Bicarbonate 

Bicarbonate ions react with mineral acid and release carbon dioxide (CO2) into the solution. 

HCO3
-+ H+ = H2O + CO2 

Apparatus 

Pipettes, Burette, Erlenmeyer flasks, Graduated pipette, Magnetic stirrer 

Reagents 

• Standard Sulphuric acid (0.01 N): Prepare 1 N acid from concentrated H2SO4 (36 N) (Dissolve 

approx 27 mL L-1 in distilled water) and standardized it with 0.01 N sodium carbonate by taking 

methyl red as indicator. 

• Methyl red indicator (0.5%): Dissolve 0.5 gram dry methyl orange powder in 100 mL. of 95% 

ethanol. 

• Phenolphthalein indicator (0.25%): Dissolve 0.25 gram of pure phenolphthalein powder in 100 

mL. of 60% ethanol. 

Procedure 

1. Pipette 5 mL. of water sample in a 125 mL conical flask and add 2-3 drops of phenolphthalein. If 



 

pink color appears it indicates the presence of carbonates. 

Then titrate it with 0.01 N sulphuric acid with the help of a burette till the solution 

becomes colorless. Record this reading and designate this reading as Y. 

Now add 3-4 drops of methyl red indicator and titrate again, till the colour changes from yellow 

to rose red and record this reading also and designate it Z. 

Calculations 

If N1 and V1 are normality (CO3
2- conc.) and volume of aliquot and N2 V2 are the normality and 

volume of H2SO4 used respectively, then 

N1 V1 = N2 V2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Where: 

2 = Valance of carbonate 
Y= Volume of titrant against phenolphthalein indicator (mL) 
Z = Volume of titrant against methyl red indicator (mL) 
V= Volume of water sample used for measurement (mL) 
N = Normality of H2SO4 solution 

Practical suggestions 

Standard HCl is used because H2SO4 may give rise to turbidity from calcium sulfate with Ca-rich 

samples.

  

2. 

3. 



 

Estimation of Sulphate in irrigation water 

Sulphate ions usually occur in natural waters. Many sulphate compounds are readily soluble in 

water. Most of them originate from the oxidation of sulphate ores, the solution of gypsum and 

anhydrite, the presence of shales, particularly those rich in organic compounds, and the existence 

of industrial wastes.The SO4
-- in water is determined normally by barium sulfate (BaSO4) 

precipitation. 

 

Turbidimetric method  

Principle 

This method is used for the determination of sulphate ions. Sulphate ion (SO4
2-) is precipitated in 

an acetic acid medium with Barium chloride (BaCl2) so as to form Barium sulphate (BaSO4) 

crystals of uniform size. The reaction involved is given below: 

Ba2++ SO4
2-  = BaSO4 (White suspension) 

Light absorbance of the BaSO4 suspension is measured by a photometer or the scattering of light 

by Nephelometer. 

Apparatus 

Magnetic stirrer, Colorimeter for use at 420 mm or turbidimeter/nephelometer, Stopwatch, 

Nessler tubes, 100 mL, Measuring spoon (0.2 - 0.3 mL) 

Reagents and standards: 

♦ Buffer solution A: dissolve 30 g Magnesium chloride, MgCl2.6H2O, 5 g Sodium acetate 

♦ CH3COONa.3H2O, 1 g Potassium nitrate, KNO3 and 20 mL acetic acid, CH3COOH (99%) in500 

mL distilled water and make up to 1000mL. 

♦ Buffer solution B: (required when the sample sulphate (SO4
-) is less than 10mg/L). Dissolve 30 g 

Magnesium chloride, MgCl2.6H2O, 5 g sodium acetate, CH3COONa.3H2O, 1.0 g of 

♦ Potassium nitrate, KNO3: 0.111 g of sodium sulphate, Na2SO4 and 20 mL acetic acid (99%) 

in500 mL distilled water and make up to 1000 mL. 

♦ Barium chloride: crystals, 20-30 mesh. 

♦ Standard sulphate solution: dissolve 0.5434 g of oven dry AR grade K2SO4in distilled water and 



 

dilute to 1 L. this contains 100 mg L-1 sulphate. 

Calibration 

Prepare standard curve by carrying standard sulphate solution through entire procedure. Space 

standards at 5mg L-1 increment in the 0 to 40 mg L-1range. Read mg SO4
2- present in the sample 

from the standard curve. 

Procedure 

1. Take suitable volume of sample and dilute to 100 mL into a 250 mL Erlenmeyer flask 

2. Add 20 mL buffer solution, mix well 

3. Keep the flask constantly stirred with the help of stirrer. Add 1spatula BaCl2 crystals with 

stirring. Continue stirring for 1 minute after addition of BaCl2 

4. Pour suspension into an absorption cell of photometer an measure turbidity at 5 ± 0.5 min 

5. To correct for sample colour and turbidity, run a blank to which BaCl2 is not added. 

Calculation 

mg SO4
2-L-1 = (mg (SO4

2-) form standard curve x 1000} / (mL of sample) 

 

 

  



 

Estimation of Boron in irrigation water 

In most natural waters boron (B) is rarely found in concentrations greater than 1 mg L-1, but even 

this low concentration can have deleterious the effects on certain agricultural products. Water 

having B concentrations in excess of 2 mg L-1 can adversely affect many common crops. 

However, where levels are greater than 5 mg L-1, toxicity may occur. Groundwater may have a 

greater B concentration, particularly in areas where the water comes in content with igneous 

rocks or other B-containing strata. 

The hot-water procedure is still the most popular method for measuring B, and it was introduced 

by Berger and Truog (1939), and was modified by later researchers. The B is measured 

calorimetrically using Azomethine-H (Bingham, 1982). 

Apparatus 

Spectrophotometer, Erlenmeyer flasks, Polypropylene test tubes 

Reagents 

♦ Buffer Solution: Dissolve 250 g ammonium acetate(NH4OAc), and 15 g EDTA disodium 

(ethylenediamine-tetraacetic acid, disodium salt)in 400 mL distilled water. Slowly add 125 mL 

glacial acetic acid(CH3COOH), and mix well. 

♦ Azomethine-H Solution (C17H12NNa08S2):Dissolve1 g L-ascorbic acidin 100 mL distilled water, 

and then add 0.45 g Azomethine-H, and mix well. Fresh reagent should be prepared weekly and 

stored in a refrigerator. 

♦ Standard Stock Solution: Dissolve 0.114 g boric acid(H3BO3) in distilled water, and bring to 1-L 

volume. This solution contains 20 ppm B (Stock Solution). Prepare a series of working Standard 

Solutions from the Stock Solution by diluting 2.5, 5.0, 7.5, 10.0, 12.5 and 15.0 mL Stock 

Solution to 100 mL numbered flasks by adding distilled water, and then bring to volume. These 

solutions contain 0.5, 1.0, 1.5, 2.0, 2.5, and 3.0 ppm, respectively. 

Procedure 

1. Pipette 2 mL aliquot of the natural water sample in to a 10 mL polypropylene tube. 

2. Add 4 mL buffer solution. 

3. Add 4 mL Azomethine-H solution, and mix well. 



 

4. Prepare a standard curve by pipetting 2 mL of each standard (0.5 - 3.0 ppm), and proceed as for 

the samples. Also make a blank with 2 mL distilled water, and proceed as for the samples. 

5. Read the absorbance of blank, standards, and samples after 30 minutes on the Spectrophotometer 

at 420-nm wavelength. 

6. Prepare a calibration curve for standards, plotting absorbance against the respective B 

concentrations. 

7. Read B concentration in the unknown samples from the calibration curve. 

Calculation 

B (mg L-1) = (S-A) 

Where S =B (mg L-1) from standard curve in sample  

A = B (mg L-1) from standard curve in blank. 

 

 

  



 

Estimation of Sodium in irrigation water 

The main cations present in irrigation samples are those of calcium (Ca), magnesium (Mg), 

sodium (Na) and potassium (K). In effluents, swage and waste waters heavy metals are also 

found. 

Sodium (Na)is a common element, the sixth most abundant, and present to some extent in most 

natural waters. Sodium is present in a number of minerals, the principal one being rock salt 

(sodium chloride). Sewage, industrial effluents, sea water intrusion in coastal area, and the use of 

Na compounds for corrosion control and water-softening processes all contribute to Na 

concentration in water because of the high solubility of sodium salts and minerals. Sodium levels 

in groundwater vary widely but normally range between 6 and 130 mg L-1. 

Reagents 

A. Standard stock solution (100 me Na L-1) 

• Dissolve 5.845g of AR grade dried NaCl in distilled water and make the volume to 1 L 

B. Working standard solution 

• Dilute 5, 10, 15, 20, 30, 40and 50 mL portion of the stock solution (containing 100 me Na L-1) to 

100 mL in volumetric flask to get working standards of 5, 10, 15, 20, 30, 40, and 50 me Na L-1 

concentrations. 

Procedure 

1. Filter a portion of water sample through Whatman filter paper No. 42. 

2. Calibrate Flame Photometer with a series of suitable Na standards with distilled water as blank 

sample. 

3. Measure the water samples, take the emission reading on the Flame Photometer at 589-nm 

wavelength, and record the readings. 

4. Draw a calibration curve. 

Calculations 

Na (me L-1) = Na(ppm)from calibration curve/23 

Where: 

23 = Atomic weight of Na



 

 

Estimation of Calcium and Magnesium in irrigation water 

Calcium (Ca) is dissolved easily out of almost all rocks and is, consequently, detected in most 

waters. Magnesium (Mg) are relatively abundant in the earth’s crust and hence a common 

constituent of natural water. Waters associated with granite or siliceous sand usually contain less 

than 10 mg of calcium per litre and less than 5 mg magnesium per litre. Many waters from 

limestone areas may contain 30-100 Ca per litre, and those associated with gypsiferous shale 

may contain several hundred milligrams per litre. But for the water in contact with dolomite or 

Mg-rich limestone may content 10-50 mgL-1 and several hundred milligrams per liter may be 

present in water that has been in contact with deposits containing sulfates and chlorides of 

magnesium. 

Calcium and Mg contribute to the hardness of water,it should be noted that the difference 

between total hardness and the Ca concentration can be used to calculate the magnesium 

concentration. However, some CaCO3 is desirable for domestic waters because it provide a 

coating in the pipes which protects them against corrosion. 

Principle 

EDTA-disodium salt solution is used to chelate Ca2+ + Mg2+. Calcium is separately estimated by 

the versenate method using ammonium purpuate (Murexide) indicator, when the pH is made 

sufficiently high, the Mg is largely precipitated as hydroxide and an indicator is used that 

combines with Ca only. Thus, Mg can be obtained by deduction of Ca from Ca+Mg content. 

Both cations can also estimated by atomic absorption spectrophotometer. 

Apparatus 

Burette (25 or 50 mL), Pipette, Stirring rods, Graduated cylinder, Beakers 

Reagents 

♦ Buffer Solution (NH4Cl-NH4OH): Dissolve 67.5 g NH4Cl in 570 mL concentrated NH4OH, and 

transfer the solution to a 1 L flask, let it cool, and bring to volume. 

♦ Eriochrome Black T Indicator: Dissolve 0.5 g eriochrome black and 4.5 g hydroxylamine 

hydrochloride in 100 mL 95 % ethyl alcohol. Prepare a fresh batch every month. 

♦ Ethylene Diaminetetraacetic Acid Solution (EDTA), 0.01N: Dissolve 2 g EDTA, and 0.05 g 



 

 

magnesium chloride (MgCl2) in distilled water, and bring to 1 L volume. 

♦ Sodium Hydroxide Solution (NaOH), 2 N: Dissolve 80 g NaOH in about 800 mL distilled water, 

transfer the solution to a 1 L flask, cool, and bring to volume. 

♦ Ammonium Purpurate Indicator (C8H8N6O6): Mix 0.5 g ammonium purpurate (Murexide) with 

100 g potassium sulfate (K2SO4). 

♦ Standard Stock Calcium Chloride Solution (CaCl2.2H2O), 0.01.:Dry about 3 g CaCO3in an 

oven at 100 °C for 3 hours, cool in a desiccator, and store in a tightly stoppered bottle. Dissolve 

0.5 g dried CaCO3in 10 mL 3 N hydrochloric acid (HCL)and bring to1 L volume with distilled 

water. Standard stock can also be prepared by dissolving 0.735 g calcium chloride 

dihydrate(CaCl2.2H2O) in 1 L volume with distilled water. 

Procedure 

A. Calcium 

1. Pipette a suitable aliquot of water sample (10 mL natural water sample) into a 250 mL 

Erlenmeyer flask. 

2. Dilute to 20 - 30 mL with distilled water, add 2 - 3 mL 2 N NaOH solution, and about 50 mg 

ammonium purpurate indicator. 

3. Titrate with 0.01 N EDTA. The color change is from red to lavender or purple. Near the end 

point, EDTA should be added one drop every 10 seconds since the color change is not 

instantaneous. 

B. Calcium plus Magnesium 

1. Pipette a suitable aliquot of water sample (10 mL natural water sample), dilute to 20-30 mL with 

distilled water. Then add 3-5 mL buffer solution. And a few drops eriochrome black indicator. 

2. Titrate with 0.01 N EDTA until the color changes from red to blue. 

3. In order to standardize the EDTA solution used in the determination of Ca and Mg: 

• Pipette 10 mL 0.01 N calcium chloridesolution, and treat it as in determining Ca and Ca+Mg 

procedure, respectively. 

• Take the reading, and calculate EDTA normality: 



 

 

 

Calculation 

 

 

Practical suggestions 

♦ In most water nearly all of the hardness is due to Ca and Mg, which react with soap to form 

precipitates .This in increases soap consumption, and react with certain constituents to form 

scale. As a general rule, a value less than 60 is considered soft, and values above 200 are 

considered very hard. 

♦ If an Atomic Absorption Spectrophotometer is used, a small aliquot of the water sample is 

sufficient to determine Ca and Mg. 

♦ Orthophosphate precipitates Ca at pH of the test. Strontium (Sr) and barium (Ba) interfere with 

the Ca determination, and alkalinity in excess of 300 mg L-1 may cause an indistinct end-point 

with hard waters. Under the conditions of the test, normal concentration of the following ions 

causes no interference with the Ca determination: Cu, Fe, Mn, Zn, Al, Pb, Cu, and Sn. 
 

  



 

 

 

Estimation of Water quality indices and suitability 

After determination of water samples for different parameters like total salts (EC), cations and 

anions, it is imperative to calculate some indices in order to asses water quality and its 

subsequent effect on soil as well as plant growth. 

Sodium Adsorption Ratio (SAR): 

It is calculate to indicate the sodicity or alkalinity hazards of irrigation water. 

SAR= 

Residual sodium carbonate(RSC): 

The RSC may be calculated simply by subtracting the quantity of Ca + Mg from the total of the 

carbonates and bicarbonates determined in different samples and expressed in me L-1 

RSC = (CO3
-2 + HCO3

-) - (Ca++ + Mg++)



 

 

 

Business idea: Development of Soil Salinity management centre 

 

Determination of soil texture by feel method and by Bouyoucos hydrometer method. 

Determination of texture by feeling of the soil with the fingers requires considerable 

practices and experience. However, one can do fairly well if the following steps are followed 

carefully. 

 

Fig: Soil Textural triangle 

 

Procedure: 

1. Determination whether the soil fits into a clay, clay loam and loam class based upon ribbon 

formation as good, medium or poor ribbon. To do this, place about ½ teaspoonful of soil in 

pour hand, Add water very slowly drop by drop, from a water bottle or the tap. Knead the soil 

all the while and bring it to the consistency of a moist, workable condition. When the soil is 

at the proper consistency try to press it into a ribbon between your thumb and fore-finger. 

2. Once it has been determined whether the ribbon is good, medium or poor, the soil may be 

classified as a clay, clay loam or loam, respectively, as indicated in above fig. 

3. When it has been determined that the given sample of soil is clay, clay loam or loam, re-

examine the sample. If it has a gritty feeling indicating the presence of sand. Call it sandy 

clay, a sandy clay loam or sandy loam, depending upon a tube of ribbon it makes. If grittiness 



 

 

 

can be detected by the teeth but not the fingers, call it a silty clay, loam or silt loam. If it is 

neither sandy nor silty but has exceptionally smooth feeling, call it clay or a clay loam 

depending the tube of ribbon it produces. 

4. Soils that are loose and single-grained when dry and form a fragile cast when moist are called 

sand. 

5. Determine texture of the sample provided and record the results on the data sheet. 

 

Observations: 

Note the textural class of the soil as per the visual observation and feel and mentioned 

textural class as per above triangle. 

 

Result : 

The textural class of the soil is  

 

Questions: 

1 .Determine the textural class of the soils as per visual observation. 

2. Differentiate between textural class given by textural triangle, ISSS and feel method



 

 

 

 

Reference URL 

 https://www.youtube.com/watch?v=GWZwbVJCNec 

 

Determination of soil texture by Bouyoucos hydrometer method. 

The process of determining the amount of individual soil separates below 2 mm in 

diameter i.e. sand, silt and clay is called particle size analysis. It consists of determination of the 

percentage of various sized particles. (Sand, fine sand, silt and clay) as they exist in the soil. An 

essential first step is to separate the particles so that they function as individuals. This is called 

dispersion. The completely dispersed individual primary particles are usually referred to as 

textural separates. 

Method of particle size Analysis. : 

Principle : 

The hydrometer method is based on the principle that the density of the suspension at the 

given depth decreases as an initially homogeneous dispersed suspension settles. The rate of 

decreases in density at the given depth is related to the settling velocities of the particles, which 

in turn, are related to their sizes. The time required by the particles of a given size to settle can be 

calculated by using strokes Law. 

 Stroke’s Law : 

Strokes (1851) stated that the velocity of a falling particle is proportional to the radius 

square and not to its surface. Equationally. 

𝑉 =
2

9
(

𝑑𝑝 − 𝑑

𝜂
) 𝑔𝑟2 

Where 

V = Velocity of settling particle 

dp = density of particle 

d = density of liquid 

g = acceleration due to gravity 

r = radius of particle 

𝜂 = Viscosity of liquid 

 

Apparatus and Equipments 

1) Dispersing machine - Mechanical stirrer 

https://www.youtube.com/watch?v=GWZwbVJCNec


 

 

 

2) 1000 ml cylinders without spout with rubber stoppers/spout 

3) Thermometer (Fahrenheit scale) 

4) Wash bottle. 

5) 600 ml beaker with cover 

6) Hot plate or water bath. 

7) Bouyoucos hydrometer. 

8) Watch glass. 

9) Chemical balance. 

10) Oven 

Reagents : 

1) 5 per cent sodium hexametaphosphate (dispersing agent ) 

2) 30 per cent Hydrogen peroxide 

3) Amyl alcohol. 

Procedure : 

1) Weight 40 g sample of air-dry soil passed through 2 mm sieve in duplicate. Dry one of the 

samples in the oven at 1050 C to determine the moisture content of soil. Meanwhile transfer the 

other sample to a 600 ml beaker and add to it 200 ml of distilled water. 

2) Add 4 to 5 ml of 30 per cent H2O2 cover the beaker with watch glass and place it on water bath 

until most of the organic matter is destroyed, then remove the beaker from water bath and allow 

it to cool. 

3) Repeat the process until the colour of the suspension ceases to become lighter or until frothing 

stops. 15 ml of H2O2 will usually be sufficient for a 40 g sample but more may be needed for 

soils high in organic matter. After the last addition of H2 O2 the beaker with soil is placed on the 

water bath for two hours to  remove the excess H2 O2 . 

4) While waiting for the oxidation of the organic matter, put 10 ml of sodium hexametaphosphate 

solution in 1000 ml cylinder and fill the cylinder with distilled water to make exactly one litre. 

Mix the suspension thoroughly and bring it to room temperature. Insert the hydrometer into the 

solution carefully and determine the scale reading. Record this reading as RL, the calibration 

correction. 

5) Transfer the organic matter-free soil sample to the dispersing cup, fill it with distilled water to 

the level of 4 cm from the top and add 10 ml sodium hexametaphosphate solution. Allow the soil 



 

 

 

to soak it for at least 15 minute. Then stir the soil suspension in the cup with the help of high-

speed electrical stirrer for 10 minutes. 

6) Pour and wash the contents of the dispersing cup into the special one litre cylinder with distilled 

water up to one-liter mark. Place a rubber stopper over  the mouth of cylinder and shake it 

mechanically end-over-end for one minute. 

7) Place the cylinder on the table and note the time immediately. Take the first hydrometer reading 

after 4 minute when the particles larger than 0.02 mm in diameter have settled (start inserting the 

hydrometer 10 seconds in advances of reading time). If the surface of the suspension is frothy, 

add one drop of amyl alcohol. 

8) Remove the hydrometer carefully and wash it with distilled water. Measure and record the 

temperature of the suspension. The hydrometer is calibrated at 670F  at any other temperature a 

correction must be applied if the working temp is above 670F the correction is added, if below 

670F the correction is subtracted. The correction is equal to the difference between working 

temperature and 670 F multiplied by 0.2 

9) Allow the suspension to remain undisturbed and re-insert the hydrometer at the end of two hours 

after the initial shaking was stopped. Now the particles larger than 0.002 mm. I.e. sand + silt will 

have settled. Record the  hydrometer reading. 

10) Calculate the percentage of sand, silt and clay in soil sample. 

 

Observations 

1. Hydrometer reading at minutes - R4 

2. Hydrometer reading at 2 hours - R120 

3. Oven dry weight of soil sample - W 

4. Temperature correction - r 

5. Calibration correction - RL. 

 

 

Calculations: 

𝑷𝟒 =
𝑹𝟒 − 𝑹𝟐 + 𝒓

𝑾
𝟏𝟎𝟎 

𝑷𝟏𝟐𝟎 =
𝑹𝟏𝟐𝟎 − 𝑹𝑳 + 𝒓

𝑾
𝟏𝟎𝟎 



 

 

 

 

Calculate P4 from the 4 minute reading and P120 from the 2 hours since P120 = % Clay and 

P4 = % silt + % clay, then we may say that. 

 

% Sand = 100- P4 

% Silt = P4 - P120 

% Clay = P120 

 

Results :  

Textural class of the soil is 

 

Questions : 

1. Define particle size of analysis.. 

2. Explain Stokes Law and how is it applied in soil particle analysis? 

3. Explain the role of H2O2 in the particle size analysis. 

4. Why organic matter is destroyed? 

5. What is the role of Sodium hexametaphosphate? 

6. Mention the size of different soil particles. 

Reference: 

1) Khanna, S.S. and Yadav, D.V. 1979. Practical Manual for Introductory courses in soils. pp. 33-

43. 

2) Piper C.S. Soil and Plant analysis 1966. 

 

Reference URL 

 https://www.youtube.com/watch?v=GfDW3Fw9cL0 

 

 

  

https://www.youtube.com/watch?v=GfDW3Fw9cL0


 

 

 

Determination of Soil Suction by Tensiometer 

Tensiometer is widely used for years together to measure soil tension/suction which can be used 

as the guide for scheduling irrigation. It is relatively cheaper, simple and easy to install. It works 

over a range of soil moisture tension of 0 to 0.8 bars. Tensiometer consists of a fine porous 

ceramic cup of 7.5 cm long connected with a manometer or vacuum gauge through a plastic tube. 

 

 

 

 

Tensiometer 

 

The manometer or vacuum gauge indicates vacuum pressure created relative to 

atmospheric pressure. Tensiometer is filled with water and is made air tight. Now, if the porous 

cup is placed in relatively dry. Soil water will come out through the pores of the ceramic cup to 

attain equilibrium between the suction on manometer or gauge and the soil (matric potential). 

This leads to a drop of hydrostatic pressure which is measured by manometer or vacuum gauge. 

 

Characteristics of a Standard Porous Cup 

The material of the ceramic cup should he such that it will pass through the following standards: 

(i) Air Entry Value : Air entry value is the minimum air pressure difference required to cause air leak 

through the pores of saturated cup. In the laboratory it can be tested by connecting (ho cup with a 

compressor fitted with a gauge through a plastic lube. Water saturated cup is then dipped in a 

beaker filled with water. By releasing pressure slowly from the compressor observe the point at 

which air bubbles start to appear. This is the air entry value which must be in the range of 0.8 to 

 



 

 

 

0.9 bars. 

(ii) Cup Conductivity : It is the volume of water passing through the cup wall per unit time per unit 

hydraulic pressure head difference. Its value should be 3.95 ml/ sec/ atm. 

 

Testing of Tensiometer 

Before installation each tensiometer should be tested whether it passes through standards 

otherwise reject it. 
 

Procedure 

  Immerse the porous cup of the tensiometer into water for 2 to 3 days to get it saturated. 

 For tensiometer having manometer add some mercury to the manometer and then fill the 

tensiometer and manometer with water. In case of tensiometer with vacuum gauge fill the 

tensiometer with water only. 

• Close the opening of the tensiometer with the cap to make it air tight. 

• Dry the porous cup in air so that about 0.7 bar suction develops on the tensiometer. 

• Oil dipping the cup in water for good tensiometer the suction goes down to zero within 5 

minutes. 

Installation 

 Make a hole in the field to slightly deeper than the desired depth with the help of screw type / 

tube auger having almost same outer diameter as that of porous cup. 

 Drop some amount of loose excavated soil of the same depth and some amount of water into the 

hole. 

 Insert the tensiometer ensuring close contact of the cup with the field soil. 

 Compact the soil around the tube and make a small heap with the soil to avoid water stagnation. 

 Fill the tensiometer with deaerated water; tensiometer will show zero reading. 



 

 

 

 With time as water from the cup will come out to the soil to attain equilibrium record the 

tensiometer readings. 

 Correlate the tensiometer readings with soil moisture content. 

Calculation 

Say, 

In case of tensiometer with vacuum gauge: 

Matric potential (Φm) = - (Fg * Rg) + Z 

Where, Fg = Gauge factor (suction value for each unit of gauge reading) 

Rg = Gauge reading 

Z = Vertical distance from the centre of the cup to the centre of dial 

 

 

 

 
 

 

 

 

  



 

 

 

Business idea: Development of seed testing laboratory 

 

Development of Seed Testing Laboratories 

Seed Testing 

Seed testing is determining the standards of a seed lot viz., physical purity, moisture, germination 

and ODV and thereby enabling the farming community to get quality seeds. The Seed Testing 

Laboratory is the hub of seed quality control. Seed testing services are required from time to time 

to gain information regarding planting value of seed lots. Seed testing is possible for all those 

who produce, sell and use seeds. 

Objective & Importance of Seed Testing  

Seed testing is required to achieve the following objectives for minimising the risks of planting 

low quality seeds.  

1. To identify the quality problem and their probable cause  

2. To determine their quality, that is, their suitability for planting  

3. To determine the need for drying and processing and specific procedures that should be used  

4. To determine if seed meets established quality standards or labelling specifications.  

5. To establish quality and provide a basis for price and consumer discrimination among lots in 

the market. The primary aim of the seed testing is to obtain accurate and reproducible results 

regarding the quality status of the seed samples submitted to the Seed Testing Laboratories. 

Importance The importance of seed testing was realized more than 100 years ago for assured 

planting values. The adulteration of vegetable seeds by stone dust which was packed in some 

parts of the world particularly in Europe. Seed testing has been developed to aid agriculture to 

avoid some of the hazards of crop production by furnishing the needed information about 

different quality attributes viz., purity, moisture, germination, vigour and health. Quality control 

of seed depends on the different seed testing protocols which determine the genuineness of the 

cultivar. Testing of seed to evaluate the planting value and the authenticity of the certified lot. 

Seed testing is required to assess the seed quality attributes of the seed lots which have to be 

offered for sale. These quality attributes are seed moisture content, germination and vigour, 

physical and genetic purity, freedom from seed borne diseases and insect infestation. In India, 

seed testing is done mainly for moisture, germination and physical purity of seeds. Standard seed 

testing procedures for the evaluation of the seeds were developed by ISTA. It is obligatory on the 

part of the seed analyst to follow rules prescribed by ISTA (ISTA, 1985) if the seed is moving to 



 

 

 

the International trade. The seed testing procedures which are described below are based mostly 

on the international rules because most of our rules (Chalam et al.. 1967) are based on, ISTA, 

1996. Economic yield of a crop depends on the quality of seeds which can be evaluated by seed 

testing (1STA, 1996). The testing of seed quality is carried out on seed samples drawn from seed 

lot to be used for cultivation. The quantity of seed sample taken for testing in laboratory is 

minute compared to that of seed lot it represents. 

Role of Seed Testing Laboratories  

Sampling in Seed Testing Laboratory The seed samples received in the laboratory (submitted 

sample) are required to be reduced to obtain working samples for carrying out various tests. A 

number of methods are available for obtaining working samples. Mixing and dividing of seeds 

The main objective of mixing and dividing of seeds is to obtain the representative homogenous 

seed sample for analysis by reducing the submitted sample to the desired size of working sample.  

 

 

  



 

 

 

Testing of Seed Viability (Kittock and Law, 1968) 

Principle: Tetrazolium (TZ) testing is a rapid method (can be finished within less than two 

days) for the evaluation of seed viability. This method has been widely used by seed scientists to 

assess germination potentials, to determine the extent of seed damage, and to evaluate seed vigor 

and/or other seed lot problems. 

The principle of TZ testing is based on the presence of dehydrogenase activity in viable seed 

tissues during the respiration process. Dehydrogenase can catalyze the colorless 2,3,5 triphenyl 

tetrazolium chloride solution into a red dye formazan. Therefore, living tissues of seeds that 

imbibe tetrazolium chloride will be stained red, while dead tissues will retain their natural color. 

Apparatus: Spectrophotometer 

Reagent:  

1. Sprouted embryo of cereal, proteinaceous and fatty seed 

2. Distilled Water 

3. 2,3,5 triphenyl tetrazolium chloride 

4. 2-methoxy ethanol 

Procedure: Seed viability test of seed was estimated following the method of Kittock and Law 

(1968) with minor modifications. Ten seeds of each category seeds were placed for germination 

on the petridish at 20±1°C. After 24 h of germination, twenty uniformly sprouted embryos for 

each treatment was taken in a 10 ml capacity glass vial and then incubated with 2 ml of 0.2% 

solution of tetrazolium chloride for 3 h at 30°C in dark. After incubation, the tetrazolium 

chloride solution was decanted off and the embryos were thoroughly washed with distilled water. 

Five milliliter of methyl cellosolve (2-methoxy ethanol) were added on the vial containing 

embryos and kept for 8 h at room temperature (28±1°C) for red colour development (formazan 

Observations: The red colour intensity of solution was measured in the Spectrophotometer at 

470 nm.  

Result: The red colour or development of formazan due to activity of dehydrogenase activity 

shos only in viable seeds.  

Activity of viable seeds are measured in……………….. OD value. 

 



 

 

 

Seed Germination Test 

Principle: The purpose of laboratory testing of seed germination is to assess seed quality or 

viability and to predict performance of the seed and seedling in the field. A NOTIFIED 

laboratory under SEEDS ACT or qualified laboratory of ISTA for testing seeds must test seed 

processed for sale. The ultimate aim of testing the germination in seed testing laboratory is to 

obtain information about the planting value of the seed sample and by inference the quality of the 

seed lot. In addition, the laboratory germination results are also required for comparing the 

performance potential or superiority of the different seed lots.  In general, the farmers, seeds men 

and public agencies use the germination results for the following purposes: 

1. Sowing purposes, with a view to decide the seed rate to achieve desired field establishment. 

2. Labeling purposes. 

3. Seed certification purposes. 

4. Seed Act and Law Enforcement purposes. 

 

Procedure: Seeds are placed on one or more layers of moist filter paper or blotter paper in 

petriplates. These petriplates are covered with lid and placed inside the germination cabinet. This 

is suitable for those seeds which require light. 

Precautions: before germination seeds may be treated with fungicide for fungal occurrence. 

Observation 

Types of seed Germination % Root length 

(mm) 

Shoot length 

(mm) 

Total Seedling 

Length (mm) 

     

     

     

 

Result: Germination of seed with seedling length measured by ……..mm. 

 

 

 

 

 



 

 

 

Seed Physical Purity Test 

Principle: The purity analysis of a seed sample in the seed testing laboratory refers to the 

determination of the different components of the purity viz., pure seeds, other crop seeds, weed 

seeds and inert matter. The objective of the purity analysis is to determine whether the submitted 

sample conforms to the prescribed physical quality standards with regard to physical 

components.  

Procedure:  

Sample preparation: The purity analysis is done on the working sample of prescribed weight 

drawn from submitted sample. The analysis may be made on one working sample of the 

prescribed weight or on two sub-samples of atleast half of this weight, each independently 

drawn.  

Weighing the working sample: The number of decimal places to which the working sample and 

the componenets of the working sample should be weighed is given below. 

Purity separation: The working sample after weighing is separated into its components viz., 

pure seed, other seed crop, weed seed and inert matter.  

Pure seed: The seeds of kind / species stated by the sender. It includes all botanical 

varieties of that kind / species. Immature, undersized, shrivelled, diseased or germinated seeds 

are also pure seeds. It also includes broken seeds, if the size is >1/2 of the original size except in 

leguminacea, and cruciferae where the seed coat entirely removed are regarded as inert matter.  

Other crop seed: It refers to the seeds of crops other than the kind being examined. 

Weed Seed It includes seeds of those species normally recognized as weeds or specified under 

Seed Act as a noxious weed.  

Inert matter: It includes seed like structures, stem pieces, leaves, sand particles, stone 

particles, empty glumes, lemmas, paleas, chaff, awns, stalks longer than florets and spikelets.  

Method of purity separation  

Place the sample on the purity work board after sieving / blowing operations and separate into 

other crop seeds and inert matter. After separation, identify each kind of weed seeds, other crop 

seeds as to genus and species. The names and number of each are recorded. The type of inert 

matter present should also be noted. 

Calculation  

All the four components must be weighed to the required number of decimal places. The 



 

 

 

percentages of the components are determined as follows.  

 

                                   Weight of individual component  

% of components = __________________________ X 100     

                                     Total weight of all components  

 

  



 

 

 

Electrical conductance of seed leachate (Anderson et al., 1964): 

Principle: The conductivity test is a measurement of electrolytes leaking from seeds. Changes in 

the organization of cell membranes occur during the development of seeds prior to physiological 

maturity, seed desiccation before harvest, and during imbibition prior to germination (ISTA 

1995). 

Apparatus: Conductivity Bridge (cell constant 0.756). 

Reagent: Distilled water  

Procedure: Electrical conductance of different category seeds were measured under ambient 

conditions. The electrical conductivity of seed leachate was done following the method of 

Anderson et al., (1964). Twenty wheat seeds were soaked in 30 ml distilled water for 30 min and 

then electrical conductance was measured in Conductivity Bridge (cell constant 0.756). 

Observation:  

Types of seed Measure of electrical Conductance(dsm-1) 

  

  

  

 

Result: Electrical conductance of different category seeds measured as ………………..dsm-1 

 

  



 

 

 

Determination of test weight 

Principle: The objective is to determine the weight of the 1000 seed from the submitted sample 

to determine the quality of the product. The working sample shall be the entire pure seed fraction 

of purity analysis. Either the whole working sample of replicates from it may be used. 

 

Procedure: Count sample pure seeds and multiply with 1000 seed. 

 

Calculation:  

                                        Weight of pure seed sample  

Test weight  = __________________________ X 100     

                            Total weight of sample 

  



 

 

 

Development of GIS and RS based soil mapping 

 

 

Introduction to GIS and RS software: downloading ,installation, plugins 

Objective: Understand the basic concept of GIS, raster, vector,projections,geo-processing and 

analysis.Use a GIS for basic skills in: thematic mapping, importing tabular data and GIS 

interpretation, basic vector data analysis, finding and using open access data, styling and map 

design. 

Software: Quantum GIS 3.6.3 

System/Hardware Requirements: 

 Processor-CPU : core i7 64 bit Processor 

 Memory RAM : 8 GB or more 

 Hard Disk : SSD de 128 Gb or 500 Gb SATA 

 Graphic card : 2 Gb RAM 

 Operating System : Windows 10 

Web Browser : Google Chorme 

Quantum GIS is an Open Source Geographic Information System. The QGIS software package 

currently runs on most versions of Unix, Windows and Mac OS X and supports a number of 

common raster and vector data formats. QGIS is available under the GNU General Public 

License (GPL). 

QGIS aims to be a user-friendly GIS,providing common functions and features.The initial goal 

of the software was to provide a GIS data viewer. QGIS is available at no cost to users and 

provides an alternative to costly GIS software. 

Methodology: 

Downloading QGIS Software:  

Steps followed 

Step1. To install the software QGIS must choose the web browser of your choice on your 

computer (for demonstration we are using Google Chrome).In your preferred web browser 

navigate to the QGIS download page: http://www.qgis.org/en/site/forusers/download.html 

Step2. Based on your operating system (Mac OSX, Windows, Unix) locate the “latest release” 

and download the “QGIS Standalone Installer.” The examples below outline the Download for 



 

 

 

Windows and Mac OSX (Version3.6.3) 

*If you are a Windows user, be sure to check your machine and download the correct file based 

on system type (32 bit vs. 64 bit). This can be done by right clicking on “Computer” in the start 

menu and selecting “Properties” 

Installing QGIS Software: 

1. After the file download has completed (about 2-5 minutes depending on connection), run the 

‘.exe’ program. The file name will be similar to “QGIS-OSGeo4W-3.6.3-1-Setupx86_64.exe” 

and can be located in your default downloads folder.    

2. After running the file and accepting the terms of agreement, select where you would like the 

program saved under “Destination Folder” (default is recommended).  

 3. Select the components to install.  

4. Click “Install.” 

5. After the installation, shortcuts will be placed to the desktop and the start menu. To open 

QGIS, click on the “QGIS Desktop 3.6.3” or QGIS Desktop 3.6.3 with GRASS 7.6.1” icon. 

QGIS Plugins: 

Plugins in QGIS add useful features to the software.Plugins are written by Qgis developers and 

other independent users who want to extend the core functionality of the software.These plugins 

are made available in QGIS for all the users. 

Plugins are optional tools that you can download and import into your QGIS for additional 

functionality.  

A useful plugin for QGIS is ‘Georeferencing GDAL’. This is core plugin-meaning it is already 

part of your QGIS installation. You just need to enable it. 

1. After opening the QGIS Desktop application, Go to the Plugins > Manage and Install Plugins 

and enable the Georeferencer GDAL plugin in the installed tab. 

2.The plugin isninstalled in the Raster menu. Click on Raster> Georeferencer to open the plugin. 

 

Conclusion:  

 

  



 

 

 

Geo-referencing of a toposheet in GIS software 

Objective: Geo-referencing a toposheet by using graticule intersections 

in a known coordinate system and datum.  

Software: Quantum GIS 3.6.3  

eoreferencing is a process of establishing a mathematical relationship 

between the image coordinate system and the real world spatial 

coordinate system. This mathematical relationship can be assigned by 

any one of the transformation settings, viz. Polynomial order 1, 2 or 3, 

Linear, Projective and Thin Plate Spline etc. Polynomial order 2 is the 

most widely used transformation in Georeferencing. Recently Thin plate 

Spline gaining popularity due its ability of incorporating the local deformations in the data, this 

is very useful when we are dealing with low resolution data. However in this practical we are 

using traditional polynomial order 2 transormation or Thin plate Spline to perform 

georeferencing/rectification of the Toposheet. 

 

Workflow:  

1. Open QGIS software 

2. Add the topo sheet 

3. Open georeferencer and add the import the topo sheet 

4. Add GCP points or add points from map canvas 

5. Transformation settings 

6. Start georeferencing process 

 

Methodology: 

1. Registering a raster images using GCP’s (Ground Control Point) 

1. We start by opening the georeferenced image in QGIS by clicking on the 'Add Raster layer' 

button  or via the Menu bar (Layer > Add Layer >Add Raster layer) 

2. Click on Raster >Georeferencer to open the Georeferencer GDL plugin. 

The plugin window is divided into 2 sections. The top section where raster will be displayed and 

bottom section where table showing your GCPs will appear. 

3. Go to File > Open Raster.Browse to the folder,select image (Toposheet.tif) and click open. 

G 



 

 

 

4. Image will be loaded in the top section.Need to assign coordinates to some points on this map. 

To georeference an image we use Ground Control Points (GCPs). GCP is a location on the earth's 

surface with known coordinates on both earth and Toposheet.Zoom to area and click on Add 

Point Tool and click on the image location. 

. 

5. To start adding GCPs to our map, we first zoom to a corner of the map where we can easily 

identify the intersection of the latitude and longitude. Use the scroll wheel of the mouse to zoom 

in and out of the map. Use the  'Pan' Button when needed. 

6. In the pop-up window,entercoordinates.Remember that X=longitude and Y=latitude.Click ok. 

 

we will require minimum 6+1(for check) i.e., 7 GCPs or more GCPs on the map. Therefore, we 

need to mark atleast 7 GCPs. The GCPs locations should be spread out as much as possible and 

they should not be co-linear at the same time they should enclose our whole area. Use the above 

procedure to mark six more control points. 

7. Go to Settings >TranformationSettings.In the Transformation Setting Dialog ,choose The 

Transformation Type as Thin Plate Spline.Resampling method >Nearsrst neighbor Name Your 

output raster as toposheet_referenced.tif.ChooseEPSG:4326(EPSG: European Petroleum Survey 

Group) as the target SRS so the resulting image is in a widely compatible datum.Make sure the 

Load in QGIS when done option is checked. Click ok. 

8. Back to Georeferencerwindow,Go to File >  'Start Georeferencing' 

Button. The processing will take at about 2 minutes.Once the process finishes,you will see the 

referenced raster layer (toposheet_referenced.tif)loaded in QGIS. 

 

 

2. Registering a raster images using Map canvas 

In case, the GCPs are not available to the users, georeferencing process can be done by using a 

map which is already georeferenced. In the step no 4 (Registering a raster images using GCP’s 

(Ground Control Point)), Go to Add pointTool and click on the image location. Then select 

From map canvas option. The display window of QGIS will open where the georeferenced 

map is already loaded. Click exactly on the same position over the georeferenced map. It will 

take the coordinates of that point. After doing the same process for at least 7 points follow the 



 

 

 

similar steps described in the above section.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Conclusion:  

 

 

 

 

 

 

 

 

  



 

 

 

Digitization and area calculation using GIS software 

Objective:To delineate different types of land use features on the toposheet. 

Digitization is the process of converting analog data into digital data sets. In GIS context 

digitization refers to creating vector datasets viz., point, line or polygon from raster datasets.  

With the help of digitization we can create different set of layers Viz. Rivers, roads, schools, 

ward boundaries and building blocks from a single map; this process is known as Vectorization. 

Vector data is easy to edit, update and is more accurate as compared to raster data. Vector data is 

more efficient for GIS analysis.  

Vector data is mainly of three types – 

 Point: It consists of single points having (X, Y) coordinates, for example lamp posts, bus  

stops and postbox positions etc.   

 Line: It consists a series of (X, Y) coordinates in a sequence (from start node to end node with a 

number of vertices joining these two nodes). For example roads, power lines, ward boundaries 

and contours etc. 

 Polygon: It is a series of (X, Y) coordinates in a sequence closing a figure where first  

and last points are the same. For example lakes, building blocks, village blocks, ward  

areas and forests etc 

Workflow: 

1. Open QGIS software 

2. Import the raster layer 

3. Create a new shapefile layer 

4. Choose the type of features (point, line or polygon) 

5. Add the field names and add those to the list 

6. Save the file with projection system 

7. Select the file in the layer panel and activate the Toggle editing option 

8. Digitize the features using Add feature tool  

9. Calculate the area and length of polygon and line features respectively using the field calculator  

 

 

Detailed methodology: 

 

Open the raster layer of georeferenced toposheet in the map canvas of Quantum GIS via, ‘Main 



 

 

 

menu bar >Layer >Add Raster Layer’ >browse and select the georeferenced raster 

layer>Click on ‘Open’ in the popup window.  

Set snapping options: 

1.Go to view menu > Toolbars>Snapping Toolbar 

2. In the Snapping toolbar,First click the Advanced Configuration option,then Open Snapping 

Options;then open snapping options;as shown in the below figure 

 3. Now set the following things as shown given below 

 
 

 

Rater to vector conversion(also called screen  digitization) 

1. To start digitization of polygon boundary,click Toggle editing tool on the Digitizing toolbar. 

2. Click Add Polygon Feature Tool.to begin Digitizing. 

3. To place last point right click .this will finalize the feature and show attribute dialog > click ok > 

click Save layer editing tool. 

Geographic area calculation: 

1. Select the Polygon/Line layerfrom layer panel. 

2. Click the Open Field Calculator tool present in the 

Attribute toolbar. 

3. Select the crate a new field checkbox to save the 

calculation into a new field. 

4. Add Area/Length as Output Field name and Decimal 

number(real) as Output field type and define Output field 

length to be 10 and Precision 5. 

5. Now double click on function $area for area and $length for length in the Geometry Group to 

add it into the Field calculator expression box. 

 

Conclusion:  



 

 

 

Field data collection using GPS device and data import to QGIS 

Objective: To collect the field data (location) and import data to GIS system 

 

Instrument: GPS Garmin e trex 10 

 

Methodology: 

1. Visit to the field. Collect the location (longitude and latitude) data using GPS device. 

2. Note the location data. Save the data in a “.csv” (comma separated value) file 

3. Import the “.csv” file in the QGIS through: Layer          Add layer          Add delimited text layer 

4. Data is imported as point file in the GIS system 

 
 

5. Export the file as a “.shp” file (vector file) 

6. Open the attribute table of the vector file 

7. Activate the “toggle editing” and add a new filed in the attribute table.  

8. Fill the newly added fields with the information collected during field visit corresponding to a 

particular location 

 
 

Conclusion: 

 

 

 

 

  



 

 

 

Collection of open source satellite data and DEM ,Rainfall data, and Soil Map 

Objective: To know and collect the open source satellite images. 

Web Browser: Google Chrome 

Data: For estimate the average soil loss due to erosion , we collect data from different sources. 

The following data is used to complete the task. 
 

Download LANDSAT Satellite Data 

Landsat :represents the world’s longest continuously acquired collection of spacebased 

moderate resolution land remotesensing .All Landsat data are available to the public at no cost 

from U.S. Geological Survey (USGS) websites. 

The USGS Earth Explorer interface uses Google Maps. You can zoom in and out with the mouse 

wheel as if you are in Google Maps. Google street view is also enabled, where you can drop a 

marker and get a real view of the location. 

Download Landsat Satellite Data 

 

First, you’ll have to create an account with USGS. In the top-right corner, click 

the  Register  button. As it’s a pretty painless process, you’ll receive instructions to activate your 

account. 

 

STEP 1. Register as a user of USGS data and create an account. To be able to download data 

from Earth Explorer sites, you must first register and create an account. To register and create an 

account, go here: https://earthexplorer.usgs.gov/register/?return TIP: Be sure to prior to starting 

your search for Landsat scenes on USGS as the system will not let you download any data unless 

you are logged in. 

STEP 2. Log in (after registering) 

1. Search criteria > Enter search criteria > Select a 

Geocoding Method  > Path/Row > polygon  >  enter 

Path and Row number > show or at first study area 

find out > click Use map  

2. Data Range  >  Search from and to > Search months   

3. Cloud cover range 0 to 10% 

4. Data sets > Landsat > Landsat Collection 2  Level -1 > 

Landsat 8 OLI/TIRS C2 L1 or Landsat 4-5 Tm C2  L1 

5. Results > Click on the green download arrow   

https://earthexplorer.usgs.gov/


 

 

 

 

Download DEM ,Rainfall data, and Soil Map 

1. SRTM Digital elevation model (USGS Earth explorer). The spatial resolution of DEM is about 

1 arc second.  

2. Annual average rainfall data is required to calculate R factor. Month wise rainfall data of 

Darjeeling district (2016) is collected from the climateknowledgeportal.worldbank.org website.  

3. The soil map is collected from the EUROPEAN SOIL DATA CENTRE (ESDAC).  

4. K factor values and the C factor values for different objects are collected from USDA (1972).  

 

SL No.  Parameters  Data Used  Source of Data 

Type  

Techniques  

1  Slope  SRTM DEM  

30 m × 30m  

U.S Geological 

Survey  

30 m × 30 m 

surface slope 

model  

2  Elevation  SRTM DEM  

30 m × 30m  

U.S Geological 

Survey  

30 m × 30 m 

digital elevation 

model  

3  Rainfall  Rainfall data of 

Different 

Stations  

In 2016  

Climateknowed

geportal.worldb

ank.org  

IDW  

4  Soil  Reference 

district soil map 

1: 500,000  

USDA  Digitization  

Process  

5  Landcover  Landsat8 

OLI/TIRS  

30 m × 30m  

In 2018  

U.S Geological 

Survey  

Maximum 

likelihood 

Classification  

 

 

Conclusion: 

 

 

 

 

 



 

 

 

Creation of different types of map in GIS Software 

Objective: to use the QGIS Print layout to create a basic map. 

Map Layout is the assembling of the varies elements of a map into a single whole,including the 

map itself,itslegend,title,scale bars and other elements. 

1. Open the map layers via the menu Layer → Add Vector Layer. the layer type to ‘ESRI 

Shapefiles’. Select all the layers by clicking on one and pressing CTRL+A. Click ‘Open’ 

(Now rearrange the layers in such a way, all point features are on top to line features and line 

features over the polygon features) 

2. Let’s start the map preparation by setting the colours for the base 

polygon layers.Right click polygon.shapefile> 

properties>symbology> symbol layer type > simple fill> fill color 

choose > apply > ok 

3. Go to project >  New  print layout. 

4. You will be prompted to enter a title for the layout.So write down 

any project name and Click ok.In the print layout window,go to Add Item > Add Map 

5. Once the Add Map button is active,hold the left mouse button and drag a rectangle where you 

want to insert the map. 

6. Click on Item properties tab and enter value for scale 

7. We will add grid and zebra border to the main map.   In the item properties tab ,scroll down to 

the Grids Section > Click the Add a new grid button. 

8. By default,the grid lines use the same units and projections as the currently selected.it is more 

common and useful to display grid lines in degrees.click on Modify grid…button and click 

change…. Button next to CRS. 

9.  In the coordinate Reference system selector dialog,enter 4326 in the Filter box.From the 

results,select the WGS84 EPSG:4326 as the CRS.Click ok. 

10. Select the interval values as 0.03000 degrees in both X and Y direction. 

11. Choose the grid type as Cross. 

12. Scroll down to the Frame Section and select a frame style that suits your taste. 

13. Also check the Draw Coordinate section.Display left and right coordinates in Vertical ascending 

order. 

14. In the draw coordinate section > format >degree,minute and suffix> font change 



 

 

 

15. Now add a north arrow to the map.Click Add Item > Add picture. 

16. Click on the item properties tab > Search directories section and select the North Arrow image . 

17. Click on Add Item > Add Scale bar. 

18. Click on Add Item > Add legend. 

19. Click on Add Item > Add Lebel. 

20. Export it as Image,PDF or SVG.Click Layout > Export as image 

21. Save the project. 

 

Conclusion:  

 

 

 

 

 

 

  



 

 

 

Soil Erosion Risk mapping using RUSLE MODEL 

Objective  :  

 

1. To briefly describe the soil erodibility in the area.  

2. To estimate percentage soil loss per Landcover area  

3. To estimate area of percentage soil loss in different slope range  

4. To estimate soil loss area in different elevation  

5. To estimate annual average soil loss  

6. To estimate which area slope and elevation range is high.  

 

Softwares:  

 

Two softwares are used to done this work. For Image processing and classification purpose the 

ERDAS imagine 2018 is used. Also the ArcMap is used to calculate the R, LS, K, C factor by 

the raster calculator.  

Furthermore, it is noteworthy that for the fulfillment of the study, the entire image processing 

jobs, GIS analysis and statistical testing has been performed using:  

 

1. ERDAS IMAGINE (v 2018)  

2. ArcGIS Desktop (v 10.5)  

3. Excel (v 2007)  

4. Word(v 2007)  

 

METHODOLOGY:  

To survey the various territories of soil erosion through several models, different techniques are 

used. In this study, with help from the Revised Universal Soil Loss Equation (RUSLE) model, 

the estimation  



 

 

 

of soil erosion is made . Due to the improved nature, the RUSLE model has been utilized and 

that replica is the modified shape of the Universal Soil loss equation (USLE) and MUSEL. The 

structure of RUSLE has greater adaptability in displaying disintegration in new conditions and 

generates more productive results than USLE. The RUSLE model has some additional flexibility 

in modeling erosion in new conditions and has further economic edge over the USLE model. 

There is an advantage of using the RUSLE technique because it can be a combination of 

empirical and process-based styles, and use optimum information as compared to the Universal 

Soil Loss Equation model. RUSLE factors enable additional adaptability in scheming soil loss by 

figuring exactly into the sub-factors. This permits the gauge by separating the substance into 

more substances, from the original substance, through the transportation of deposit . The RUSLE 

model has been utilized to identify the soil erosion in this study, which is based on GIS. The 

RUSLE model equation (Equation (1)) is used to estimate the average annual soil loss.  

 

A = R × K × LS × C × P 



 

 

 

where, A = yearly mean soil loss (t ha−1 every year), R = precipitation erosivity factor (MJ ha−1 

every year), K = soil erodibility factor (t ha h MJ−1 mm−1), C = cover management factor 

(dimensionless), LS = slope length and slope steepness factor (dimensionless), and P = support 

practices factor (dimensionless). The raster calculator tool was used to multiply the parameters 

given above for the estimation of annual average soil loss of the region. The multiplication of 

isolated factors generated a combined map of soil loss. Quantity of eroded soil was taken from 

that final in terms of tons/ha/year. The outputs maps have a 90m resolution, which is acceptable 

for a regional study. The information elements of the exploration strategy came from different 

origins. The R-factor , K-factor , and P-factor  were recovered from the investigations including 

the high goals of (100 meter). Through a correlation of the ongoing, the topographic factor (LS)-

factor has been determined by comparing the Digital Elevation Model (DEM) data, as well as 

data that are analyzed from this current investigation. The information that is obtained from the 

present study has been compared to the information that was obtained through the Advanced 

Elevation Mode l (DEM).  

 

Rainfall erosivity factor (R) :  



 

 

 

R factor is the rainfall erosivity factor that is calculated by different formula which depends on 

the rainfall erosivity index. In this study the Modified Fournier’s index (IMF) is taken to 

compute the rainfall erosivity index. The rainfall erosivity is depends on the amount of annual 

average rainfall.  

 

ARNOLDUS (1978) proposed a modified Fournier Index,  

 
Where, pi is the precipitation of each month [mm] and Pt is the mean annual precipitation [mm].  

RODRIGUEZ ET AL.(2004)who used the generic ICONA equation to estimate R .We consider 

this formula to calculate R for study area.  

 

 
 

Soil erodility factor (K) :  

 

The K factor is the soil erodibility factor of any soil. Which indicates the suspectibility of soil 

erosion and the rate of run off as measured under the standard unit plot condition. Suspectibilty 

is depends on the texture of the soil. Also the permeability, presence of organic matter have an 

impact on the soil erosion. The soil erodibility factor is estimated by using the soil map and the 

K values. Collection of soil data and assigning the value of K values from field data is too 

expensive also time consuming. The soil map has been derived with the help of the European 

Soil Data Centre (ESDAC).  

 

Slope length and steepness factor (LS) :  

 

Topography plays a significant role in erosion. LS factor represent as the multiplication of slope 

length and the slope steepness that’s concern about the topographic condition of surface. Also 

the length and steepness of slope control the surface runoff speed. The slope value has been 

derived from the digital elevation model through the spatial analyst tool. Slope length is defined 

as the horizontal distance from the point of origin of overland flow to the point where either rthe 



 

 

 

slope gradient decreases enough that deposition begins, or runoff is concentrated in a defined 

channel (Renard et al.1997; Wischmeier and Smith 1978) . Slope steepness reflects the influence 

of slope gradient on erosion. For compute the LS factor we consider the following formula. 

Moore and Burch (1986) 

 

 

Cover management factor (C)  :  

 

The C factor play significant role in the RUSLE model. The cover management is associated 

with land use and land cover of the given area. It is the ratio of soil loss from a cropped land in a 

particular condition to the soil loss in a continuous fallow on the same soil and slope. The C 

factor values are assigned to the different land use and land cover classes.  

 

Support practices factor (P) :  

 

The P factor is the ration of soil loss with a particular support practices to the corresponding loss 

of up and down slope cultivation. It is calculated as the relationship between terracing and slope 

in the paddy field area also the estimation is done according to the relation between contouring 

and slope in the crop field area. Here we take the value of P as 1, because we did not have any 

field data. 

 

Cover management factor (C) :  

 

The C factor play significant role in the RUSLE model. The cover management is associated 

with land use and land cover of the given area. It is the ratio of soil loss from a cropped land in a 

particular condition to the soil loss in a continuous fallow on the same soil and slope. The C 

factor values are assigned to the different land use and land cover classes.  

 

Support practices factor (P) :  

 

The P factor is the ration of soil loss with a particular support practices to the corresponding loss 



 

 

 

of up and down slope cultivation. It is calculated as the relationship between terracing and slope 

in the paddy field area also the estimation is done according to the relation between contouring 

and slope in the crop field area. Here we take the value of P as 1, because we did not have any 

field data. 

Conclusion:  
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